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Welcome to Ocean for Techlog

Ocean for Techlog is an application development framework, part of the Ocean suite of
Schlumberger software platform frameworks, focused on wellbore data processing and
visualization. It allows the application developers to extend the functionality and
workflows of the Techlog platform.

The Ocean framework provides a productive development environment that allows the
developers to focus on science.

Ocean plug-ins are loaded on-demand by the Techlog end-user as libraries (dll) using
the Techlog module manager.

A plug-in integrates in Techlog menus and workflows like native modules. They may
appear as:

e activities started for instance through a menu item, which decide by themselves
when they are finished. They are displayed as tasks in Techlog, such that you
can monitor and possibly stop them manually.

e activities like worksteps which run within a Techlog workflow.

WAl the code snippets in this document have been built with Ocean for Techlog
2020.1.

Ocean for Techlog Advantage

Ocean is built in the Qt (cute) environment. Qt is a cross-platform application
framework that is widely used for developing application software with a graphical user
interface. Qt uses standard C++ but makes extensive use of a special code generator
(called the Meta Object Compiler, or moc) together with several macros to enrich the
language. For software developers, the use of Qt is seen as a productivity
enhancement.

Ocean is designed to promote code reusability for maintenance efficiency and
robustness. The Ocean Framework enables independent development of decoupled
modules. These modules can then be deployed independently of the main Techlog
application. This enhances robustness while preserving the evolution of the Techlog
platform.

Ocean also promotes the independence of data display and data access. Traditional
applications produce data and provide sophisticated rendering and interactions for this
data. This isolates them from other applications. In Ocean, data access and data
display are not handled by the same classes. This promotes code reuse and data
sharing in the same graphical environment. For instance, the Logview window
simultaneously shows data processed by Petrophysics, Acoustics, and Geology
modules. It becomes an essential tool for asset team collaboration.
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Ocean for Techlog Architecture

Ocean for Techlog provides lifecycle management, a runtime environment, and a public
API for plug-ins to interoperate with Techlog functionalities. Figure 1 shows how Ocean
for Techlog provides the glue between Techlog and the plug-ins.

Ocean

SR RPC connection Gl Plug-ins
Techlog host process Plug-in host process

Figure 1 Ocean for Techlog architecture: Plug-in isolation

The Ocean for Techlog architecture is based on native C++ and the Qt framework, with
plug-ins running outside of the main Techlog process. Each plug-in running in its own
process provides stability and compatibility as it:

e allows plug-ins to run in debug mode with the release version of Techlog
e avoids conflicts between third-party libraries used by the different plug-ins

e allows debugging, fixing, recompiling and rerunning a plug-in without having to
restart Techlog

e allows binary compatibility over multiple versions of Techlog and Qt
o allows isolation of Techlog in case of a crash of one plug-in

The Ocean for Techlog public API (Slb.Ocean.Techlog.dll) is the host for Ocean
applications and is the environment in which the Ocean module needs to run. The
public API provides:

e the domain objects and their data source
e the graphical environment in which the applications will display their data

e a common look and feel for all application user interface components

Access to the Techlog data model
The Ocean for Techlog API accesses these data types and properties of the Techlog

data model:
e Well
e Dataset

e Variable (Well logs)
e Data properties
e Zonation

You extend the Techlog data model by creating new data objects which are called
plug-in domain objects.
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See the “Plug-in domain object” section in Ocean for Techlog Developer Guide - Plugin
Domain Object - Importer&Exporter for more information on how to implement a
plug-in domain object with Ocean for Techlog.

Ocean for Techlog UI Infrastructure

The Ocean for Techlog API does not limit itself to accessing the Data domain of
Techlog. It also provides a rich environment for integrating the Ocean module with the
graphic environment familiar to Techlog users.

The User Interface API provides functionality to customize many elements of the
Techlog window system.

graphics
inevery pu
plots

custom
widget

Figure 2 Techlog UI extensibility

Ocean provides the capability to extend Techlog’s user interface functionality for the
GUI to be tailored to the needs of new applications. Figure 2 shows some examples of
what is customizable with the Ocean API:

e Menu bar extensions:

o Adding new tabs, groups and menus to the tbar (Techlog ribbon) or
extending native Techlog menus

e Windows:

o Adding custom windows (Qt widgets) in the Techlog workspace
e Plots:

o Adding custom plots

o Customizing native and custom plots by adding graphic items

o Adding user interactions through graphic items

o Extending the menu bar, tool bar and context menu of native and
custom plots with custom tools

e Workflow manager
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o Adding a custom user interface to an Ocean workstep

o Extending worktep properties (Techlog properties editor) with a
custom properties tab

e Importer and Exporter

o Extending import and export functionalities of the Techlog platform

Ocean for Techlog plug-in identity and activities

The PluginIdentity is an interface that the developer implements to declare some

information about the plug-in, its list of activities, and the menu items used to trigger
those activities.

This is the main entry point class of the plug-in and this class, compiled into the library,
provides identity and support information on the plug-in.

Once the plug-in library is deployed into the Extensions folder of Techlog (it could be
in the Techlog, Company or User folder), the end-user can enable or disable it in the
Techlog module manager accessible through the Navigation pane > Licensing
menu, and click on the Open the module manager button.

i Select your license configuration

@ Techlog Modules

v [] Ocean plug-ins
Ocean

O ))ﬂ GenericFileStorage
Framework

(0/1) v [ ocean examples
o . O o Helloworld
O @ Heliowond
L Default O @ MyPlugin

[J Ocean for Techlog Met example plugin
O TestRunnerPlugin
[ TestRunnerplugin

[J P WorkflowEngineDemoPlugin

Start Cancel

Figure 3 Techlog module manager

The module manager in Techlog manages the integration of the plug-in activities into
Techlog: it loads and queries the plug-in, creates actions that launch the plug-in
activities, and links them to menu items in Techlog.
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In Techlog, a module is a set of functionalities associated with a license feature. A
plug-in can contribute its activities into some Techlog modules. For instance, a plug-in
can contribute an environmental correction workstep (associated with the
environmental correction license), and can also add some geology-related processing
to the WBI (wellbore imaging) module, that is available only if the user has also a WBI
license. This means that the integration into the Techlog menus is dynamic, based on
the Techlog modules enabled by the user, and therefore subject to license checks.

% Native Techlog Module

¥ Native functionality

Native functionality

«

Native functionality

Plugin

\ |z Activi
____________—————,‘ Ll license feature A

| licerece feature B

Figure 4 Plug-ins contribute activities to modules (native or custom); modules can
be licensed.

All the activities of a given plug-in run in a single process, and multiple instances of a
given activity can run in that same process. This way, activities within a given plug-in
can communicate between each other (for instance, multiple worksteps forming a
workflow).

Ocean framework license

Ocean for Techlog is sold under a license feature called Ocean_Framework that
makes tiBase, tIAdvancedPlotting and tIPython modules available.

Ocean_Framework license feature gives access to the Ocean for Petrel and Ocean
for Studio development frameworks as well. You need to provide a dongle id when you
order the license through the Ocean store.

Creating or opening a Techlog project with an Ocean framework license marks the
project as tainted.

e Plots and reports accessing data from a tainted project have a watermark.
e Data export is prohibited.

e Once the project is tainted it can't be open with a regular Techlog license.

Qt LGPL notice

The Ocean framework is distributed with Qt LGPL 5.12.3 libraries. Per requirement of
LGPL components used, you must provide with your plug-in a notice that LGPL code is
being used. Do this by deploying with your plug-in dll (plug-in folder) the LGPL.txt file
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and the appropriately edited README.txt file that are shipped with the Ocean
framework.

Irdparty
bin
buildtools
Documentation
include
lib
win32
deme-project.zipx
, examples
= GettingStartedWithOceanForTechlog. pdf
LGPL.bet
F 04TL.props
README. et
& Version.04TL.props

Figure 5 LGPL notice files

See the “Deploy folders and files with the plug-in dll” section on page 68 for more
information on how to deploy additional files in the plug-in folder.

Open and modify the README.txt files before deploying it with your plug-in, changing
the “Ocean for Techlog Software” with the name of the plug-in at the beginning of the
file.

Microsoft Visual Studio compiler supported with Ocean

The Ocean framework is deployed with libraries built with msvc141 (Visual Studio
2017) compiler version. This means that you can build your Ocean for Techlog plug-in
with only the Visual Studio compiler 2017 version.

3rdparty ~ Name
bin N

# S|b.Techlog.Ocean.Runtime.lib
buildtools 8 S|b.Techlog.Ocean.RuntimeD.lib

Documentation
include

lib

win32

Figure 6 Ocean libraries

Binary compatibility

The commercial Ocean APIs from a Techlog major version release are binary
compatible with all of the Techlog minor version releases. The best practice is to build
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your plug-in on the Ocean Framework major version so it will run on any minor releases
of the same major Techlog version.

Note: If the plug-in depends on a new feature or a fix in @ minor release you can
build your plug-in against that Ocean framework minor release, but users of
your plug-in will then have to adopt the corresponding Techlog minor
release in order to run your plug-in.

Stability promise

The stability promise says that the Ocean API will be stable for minimum two years or
two release cycles.

In order to implement new features or adopt new designs, the Ocean API may change
over time. Any APIs that are going to be removed are marked with the “Deprecated”
attribute, and include when the deprecation happened and what the replacement API
is. The API remains available as “Deprecated” for a minimum of one release cycle
before the API is fully removed, and the plug-in code must be updated in this time
frame.

For example, the userHorizontalLimit method of the LineTrackItem class was
deprecated in the 2017 release.

# userHorizontalLowerLimit()
float Slb::Ocean:: Techlog::LineTrackltem::userHorizontalLowerLimit { ) const

Deprecated:
Since "2017.1" . Please use Slb::Ocean::Techlog::Line Trackitem::horizontalUserLowerLimit() instead.

Figure 7 Deprecated API

Any plug-ins using the deprecated userHorizontalLimit method must be changed
to use the replacement method horizontalUserLowerLimit instead.

Since you might not have the time or resources to change your plug-in immediately, in
the 2017 release both the new API horizontalUserLowerLimit and the old API
userHorizontalLimit are available. In the 2018.1 release, the old API
userHorizontalLimit is removed and is no longer available for use.
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Install and setup the Ocean for Techlog development environment

Ocean for Techlog installation
The Ocean development environment is setup by Ocean for Techlog installer.

The installer first checks if the Techlog version corresponding to the Ocean Framework
is installed on the user machine. The Ocean for Techlog package may be located
anywhere on the disk.

1. Browse the installation folder and click Next in the dialog window. (See Figure
8.)

oceaqn @ ™

Creating advantage

Ocean for Techlog 2020.1 Alpha 2

Install To

C:\Program Files\Schlumberger\Qcean for Techlog 2020.1 2 D

You must agree to the license terms before you can install the
product.

] | accept the terms in the License Agreement

Cancel

Figure 8 Ocean for Techlog install location

The installer checks:
e corresponding Techlog version is installed
e Visual Studio 2017 or 2019 is installed with v141 compiler.
2. Click Next in the dialog window. (See Figure 9.)
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oceaqn @ ™

Creating advantage

Ocean for Techlog 2020.1 Alpha 2

Prerequisite Check

Checking installed Visual Studio 2017, 2019 v

Checking installed Techlog 2020.1 Alpha 2 0 qp"

Figure 9 Techlog and VS 2017 or 2019 (compiler v141) are installed

If you have already a Techlog user folder defined on your system (TLUSERDIR
environment variable), the sample plug-ins are deployed to this folder. Otherwise the
installer deploys sample plug-ins to the user profile’s AppData in order to avoid any UAC
(User Account Control) issues.

See the “Ocean for Techlog environment variables” section on page 15 for more
information on how to setup Ocean environment variables.

The installer shows Visual Studio components installed with Ocean.

3. Select all components and click Install in the dialog window. (See Figure 10.)
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oceaqn @ ™

Creating advantage

Ocean for Techlog 2020.1 Alpha 2

Optional components

® Ocean for Techlog

[ Ocean Start Page

B Ocean Quality Assistant

[« Projects and Items Templates
[«] Techlog Headers Resolver
[«] Techlog Test Adapter

[+] Visual Studio F1 Help

Figure 10 Visual Studio components

4. After the installation a reboot may be required to get all Ocean for Techlog

Visual Studio extensions properly installed. (See Figure 11.)

oceqn @™

Creating advantage
Ocean for Techlog 2020.1 Alpha 2

Setup successful

All specified components have been installed. Reboot is required
to complete operation. If you continue without rebooting, some
features might not work as expected.

Figure 11 Setup successful
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Ocean for Techlog package content

The Ocean for Techlog Framework is deployed by the installer. The Ocean for Techlog
package has this folders hierarchy installed on your disk when installed:

3rdparty Qt 5.12.3 msvc141 (LGPL)

libraries and header files
Google.Test 1.8.1-v141

Google tests 1.8.1 msvcl41l

Qt5.12.3 librairies and header files

bin
buildtools ——> Natvis debug file for Ocean domain objects

Documentation

include Ocean runtime msvc141
lib libraries and header files
win32

2 OceanForTechlog.chm —> APl documentation CHM file

Figure 12 Ocean for Techlog package content

Plug-ins are built on Qt. The Ocean for Techlog Framework installer comes with the Qt
LGPL 5.12.3 version. It contains QtCore and QtGui libraries (the 2 most basic Qt
libraries). Those libraries are compatible with the Visual Studio compiler v141 (Visual
Studio 2017).

The Ocean for Techlog API exposes these objects:

e Base classes: gobject (plug-in classes are QObject and in particular they
expose their event handlers as Qt’s slots methods), gwidget (a simple way of
providing a custom GUI is by implementing a QWidget)

e Basic types: QString, QVariant, QImage, QColor, etc.
e Containers: QList, QMap, QHash, etc.
e Enums: Qt: : PenStyle, etc.

Google.Test 1.8.1 x64 libraries are provided with Ocean framework in order to create
an Ocean test plug-in. See the “Create unit tests for your plug-in” section on page 40
for more information on how to create Google tests for an Ocean plug-in.

The Ocean framework libraries are built with Visual Studio compiler v141 with which
the plug-in links to build with the v141 compiler.
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3rdparty <« v 4 « AppData > Roaming » Schlumberger > Ocean for Techlog 2020.1 Alpha 2 » examples
bin
buildtools DotNetExample

GenericFileStorage

Documentation eloworkd Ocean plug-ins vexproj

indude

i MyPlugin linked with msvc141 libraries

- . .
win32 7 WorkflowEngineDemoPlugin

<l demo-project.zipx

2 examples

@ GettingStartedWithOceanForTechlog.pdf
| LGPLxt

K O4TLprops

£ OceanForTechlog.chm

—| README.txt

F Version.04TLprops

Figure 13 Ocean plug-in examples

The Ocean framework installer deploys in the Ocean package home folder an example
folder link. The “examples” points to Visual Studio plug-in projects that link with Ocean
libraries and use the Visual Studio compiler v141. All these examples are deployed in

the %appdata® \Schlumberger\Ocean for Techlog 2020.1 directory.

The examples folder includes these plug-ins:

e HelloWorld: a simple plug-in useful to test your Ocean for Techlog
development environment.

o DotNetExample: shows how to integrate a .NET library in Techlog using Qt
and Ocean framework.

e MyPlugin: some code examples of each API exposed in Ocean for Techlog
o Read and write data access
o Create a workstep, add it and run it in a Techlog workflow
o Plot examples as Logview, cross-plots, custom plots
o Custom UI examples

¢ GenericFileStorage: some plug-in domain objects (custom domain objects)
code samples

The plug-in examples listed previously are built in release mode and deployed by the
Ocean framework installer into the Extensions folder of Techlog User folder. You can
modify the path to the Techlog User folder through the TLUSERDIR environment
variable or directly in Techlog through the Options window dialog.

This is described in the “"Ocean for Techlog environment variables” section.

The same known Extensions location can be added within Techlog’s multi-level folder
organization: Techlog and Company. This allows the plug-in to be deployed along
with the Techlog installation, or on the Company’s shared drive to reach many users.

W1t is not recommended for a plug-in developer to deploy a plug-in directly at the
company or Techlog level for these reasons:

e content of the Company folder is usually handled by a dedicated team within the
company

Getting Started 14
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e Techlog extensions folder hosts plug-ins deployed with the Techlog baseline as
native Techlog modules

Ocean for Techlog environment variables

In order to build your plug-ins the Ocean installer sets the TechlogSDKHome2020_1
environment variable which is the root folder path where the Ocean for Techlog
framework is installer on your disk (e.g. C:\Program Files\Schlumberger\Ocean
for Techlog 2020.1).

To see the demo plug-ins installed with the Ocean package in the Techlog module
manager, the user folder parameter is needed to say where deployed the plug-ins are.

If there is no user folder set on your machine, the installer sets the
%AppData% \Schlumberger\Ocean for Techlog 2020.1\techlog folder as
user folder and deploys the sample plug-ins in this folder. Sample plug-in code is also
deployed in the 9%AppData%\Schlumberger\Ocean for Techlog
2020.1\examples

You can change it anytime through Techlog Options window (Navigation pane >
Options > Folders).

Options

Licensing

Folders
Options Company folder 0

D\OceanForTechloghcompany folder hd
User information

Project folders ﬂ
Help D:\Software' TechloghTechlog 2017 1\Techlog 20171 Alg| | Add folder

Ci\Techlog-Projects

Delete folder

Exit Techlog

g
User folder 0

ersilguenowx\ AppData\Roaming\Schlumberger\ Techlog

Saving rules
Auto save the project every |30 |~ | minutes ﬂ'
[[] Leave Techlag without saving the workspace o

Silent auta-save when Synchronization tool starts o

Silent aute-save on low-memary with Synchronization tool 0

Figure 14  Techlog user folder

This parameter is set through the TLUSERDIR environment variable:

e TLUSERDIR =%7echlogSDKHome% |techlog if you want to use the User
folder as your target build area.
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: Close and re-open any explorer window to propagate the new environment var-
lable settings.

Ocean for Techlog property sheets

Property sheets (.props files) are deployed with the Ocean framework and are used to
setup Ocean and Qt property values needed by the plug-in project to be build in Visual
Studio.

Two main property sheets deployed at the TechlogSDKHome2020_1 root folder:

e Version.04TL.props defines:

o The Techlog version (2020.1) used by all plug-ins built with this Ocean
framework package.

o The path to QTDIR folder that contains the version of Qt libraries
shipped with the Ocean for Techlog framework.

o The path to GTests folder that contains the version of GTests libraries
shipped with the Ocean for Techlog framework.

e O4TL.props includes other property sheets as:

o AdditionalDependencies.O4TL.props and Include.O4TL.props
deployed in TechlogSDKHome2020_1\bin folder and used to
defines Ocean for Techlog libraries and header files in the Visual Studio
plug-in project.

o AdditionalDependencies.QT.props and Include.QT.props de-
ployed in TechlogSDKHome2020_1\3rdparty\Qt 5.12.3 folder
and used to defines Qt libraries and header files in the Visual Studio
plug-in project.

o AdditionalDependencies.GTests.props and In-
clude.GTests.props deployed in Tech-
logSDKHome2020_1\3rdparty\Google.Test 1.8.1-v141 fold-
er and used to defines Google Tests libraries and header files in the
Visual Studio test plug-in project.

3rdparty
bin
buildtools
Documentation
include
lib
win3d
demo-project.zipx

a  examples

=| GettingStartedWithOceanForTechlog. pdf
LGPL.bet

& 04TL.props

! OceanForTechlog.chm
README.fxt

# Version.04TL.props

Figure 15 Ocean for Techlog main property sheets
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Note: The main Ocean for Techlog property sheets are included to the Visual
Studio plug-in project template and wizard installed with the Ocean
framework to Visual Studio. Please don't modify those files as they contain
the needed Ocean and Qt property values needed to build a valid plug-in for
Techlog 2020.1 release. See the “Creating the Plug-in and Activity with
Visual Studio” section on page 21 for more information on how to create a
plug-in by template in Visual Studio.

Test the Ocean for Techlog development environment

First test if TechlogSDKHome is properly set up and the Techlog user folder is
pointing to the Extensions folder of the Ocean for Techlog development package.
Perform these steps:

1. Run Techlog and click on the Open the module manager button from the
Navigation pane > Licensing menu:

I Select your license configuration

@ Techlog Modules

v [] Ocean plug-ins

Ocean

Framework [ n GenericFileStorage

0/1) v [ ocean examples

(+] . O @ weloword

O @ welioword

& Default O B myeiugin

[[] ocean for Techlog .Net example plugin

[] TesthunnerPlugin
[ TestRunnerplugin

[ PP workflowe ngineDemoPlugin

Start Cancel

Figure 16 Release plug-ins deployed with Ocean Framework

The module manager scans the Extensions folder of the Ocean for Techlog package
and the example plug-ins built in release mode and shipped with the Ocean framework
are displayed as in Figure 16.

2. Go to %TechlogSDKHome2020_1% \examples\HelloWorld folder.

3. Open HelloWorld.vcxproj with Visual Studio and build the project in debug
x64 mode.
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®) HelloWorld - Microsoft Visual Studio W & | Quick Launch (Ctrl+Q) P - O x
File Edit View Project Build Debug Team Took Test Ocean Analyze Window Help Ludovic Guenoux = [B1

FRETTIERS crorm—"

Ocean Start Page + X
GET STARTED

P Local Windows Debugger = | 5% _

Search Solution Explorer (Ctrl+$ P
R Solution HelloWorld' (1 project)
4 % HelloWorld

b 8 References

Start P ¥% External Dependencies
- 4 . Header Files

ocean @

Creating advantage

b @ HelloWorld_precompiledh
P [ HelloWorldActivity.h
b [ HelloWerldPluginh

4 Source Files
Search b HeloWorldAciiycop
b *+ HelloWorldPlugin.cpp
@ ‘ e o n [ OceanForTechlog.rc
¥ TechlogPlugin.props

Solution Explorer IESTIE SRS

Properties

Show output from: Build

LrHELIOWOT LUACLLVILY . Cpp
1>HelloworldPlugin.cpp

1>Generating Code...

1> Creating library x64\Debug\Helloworld64D.lib and object x64\Debug\Helloworld64D.exp
1>Helloworld.vexproj -> C:i\Users\lguenoux\AppData\Roaming\Schlumberger\ocean for Techlog 2020.1 Alpha 2\
1>A subdirectory or file C:\Users\lguenoux\AppData\Roaming\schlumberger\Techlog\Extensions\schlumberger\
1>x64\Debug\HelloWorlde4D.d11l

131 File(s) copied

========== Build: 1 succeeded, @ failed, @ up-to-date, @ skipped ==========

(Name) HelloWorld
Project Dependenci
Project File CAUsers\guenou\AppE

Root Namespace  HelloWorldPlugin

(Name)
Specifies the project name
Iad Output

[J Build succeeded 4 Add to Source Control =

Figure 17 HelloWorld build in debug x64

The project must build successfully and a new debug x64 library of the Helloworld

project is generated in the Extensions folder of the Techlog user folder.

Note: In this screenshot you can see that the expected plug-in structure folder is
VendorName/PluginName/TechlogVersion/PluginVersion/. If this
structure folder is not respected the plug-in is not loaded in Techlog.

Home share Wiew

&« v < Schlumberger » HelloWorld » 20201 » 1.0 wv O

Extensions & Mame

Schlumberger HelloWorld64D.dll
GenericFileStorage “ tsdkhelloworld.dll
HelloWorld

2017.2 =

20181

2018.2
20191
2019.2
20201
1.0

MyPlugin

Figure 18 HelloWorld debug x64 library
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4.

In Techlog, open the module manager, right-click on Ocean plug-ins and click
Refresh plug-ins in the context menu. The new HelloWorld debug x64
plug-in appears in the Ocean plug-ins group as in Figure 19. Since there is one
HellowWorld plug-in dll deployed by the Ocean framework installer in the same
plug-in folder (HelloWorld release plug-in v141), once the HelloWorld plug-in is
built in debug v141 and deployed, you see two HelloWorld plug-ins in the module
manager with the same name “HelloWorld”. Next to the plug-in you can click on the
information icon and check the corresponding plug-in dIl name in the information
pane of the module manager.

Techlog 2020 - License selection f

Select your license configuration

Techlog Modules
v ] Ocean plug-ins
O o
Framenork [ )P cenericFilestorage

(/1) ~ [ ocean examples
o @ HelloWorld I-&’ o HelloWorld

O @ vetowond
& Default 0 @] wrnan Version 1.0
[ ocean for Techlog Net example plugin DLL name: HelloWorld64D.dll
0] vesteunnerpiugin Ocean version: 2020.1
[ TestRunnerplugin Level: User

Released on: 08/03/2014

Created by: Schlumberger

Vendor: Schlumberger

Supported by: mysupport@slb.com

] #¥ workfiowEngineDemoPiugin

Description:
Hello World

Figure 19 HelloWorld64D plug-in

= After you refresh the list of plug-ins in the module manager, if you get these error

messages for some plug-ins built in debug mode, it means that the Techlog plug-in
debug host process executable and its dependencies have not been deployed properly
in bin64/pluginhost folder of Techlog installation folder. Please re-install the Ocean
framework.

Error: Plugin 'myplugin64D.dllI': can't find corresponding plugin host file.

Error: Can't launch plugin host for plugin ‘'myplugin64D.dIl': host process not
running.

5.

Enable the plug-in and click the Hello World action menu in the new HelloWorld
plug-in added in Techlog. “Hello Plugin World!” is displayed in the Techlog Output
console.
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= Home Plot  Data Uty  Studio  Petrophysics  Geology ~ Geomechanics  Reservoir  Geophysics  Unconventionals  Wellboreintegrity  Productionlogging 4 » 25 &

@ Helio World

HelloWorld
Project browser
Q [search |%
(A [E @ &P |»]|§

dataset 171 | Family|
4 Datasets

boA Welll

bod Well2

b oA we

bod Wells

b Wellg

Layouts

= R ox Tabl -

w0y B

sapieq |:|‘|

Cross-plots
I Python scripts

Output

@  [2017-02-2117:44]  Hello Plugin World!

e =

Propertis | Project browser | Zonation | Wrkspace
6 rml

Figure 20 HelloWorld64D activity running
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Writing your first plug-in

The Ocean for Techlog framework provides a development and runtime environment
for wellbore centric data manipulation, interpretation, and visualization applications.
You have the ability to create workflows that interoperate with or extend the com-
mercial Techlog Interactive Suite and the capability to extend the scope of Techlog to
address new petrotechnical domains. This chapter describes the procedure of creating
a simple plug-in.

Writing the plug-in

In your first plug-in you will add a new menu item into a new tab and group in Techlog.
Clicking on this menu item will trigger an activity that prints all the well, dataset and
variable names found in the current project.

There are three main steps for creating your first plug-in. Each step will be detailed in
the sections that follow. The steps are:

1. Run the Ocean for Techlog Plug-in Wizard in Visual Studio to create the plug-in.
2. Inspect the files created by the Wizard.
3. Modify the code to add the processing logic.

Creating the Plug-in and Activity with Visual Studio

To create the project, plug-in, and activity using Visual Studio:

1. Start Visual Studio.
2. Create a new project by selecting File > New Project.

3. In the Project types area, under Visual C++ project type, select Ocean >
Techlog 2020.1.

4. Select the Ocean Plug-in template.
5. Provide the name “MyFirstPlugin” for the project.
6. Click OK to start the Wizard.
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P Recent
4 Installed

4 Visual C++

Windows Desktop

-

Cross Platform
MFC/ATL

CLR

Test

Other

4 Ocean

Techlog 2018.1
Techlog 2018.2
Techlog 2019.1

Sort by: | Default '| e Search (Ctrl+E
QOcean Plug-in Visual C++ Type: Visual C++
Ocean Plug-in |
Iﬂ Ocean Test Plug-in

ller Visual C++

Visual C++

Ocean Plug-in template

A

Techlog 2019.2 / Ocean Project type
Techlog 2020.1 —

Not finding what you are locking for?

/ Project name

Open Visual Studio Installer

Mame: MyfFirstPlugin
| Location: |C'\U5ers\lquenoux\source\repos - | Browse...
Solution: |(.'reate new solution - |
Solution name: MyFirstPlugin Create directory for solution

D Create new Git repasitory

OK Cancel

Figure 21 New project window

It is generally a good practice to use a descriptive plug-in name.

7. Change the name of your plug-in to “MyFirstPlugin”.

Create Ocean plug-in for Techlog 2020.1

8. Change the “Vendor name”, “Plug-in version”, “Support e-mail”, *Crash dump
e-mail” and “Description” fields as appropriate (See Figure 22).

9. Note that “*Vendor name”, “Plug-in name” and “Plug-in version” are mandatory

plug-in information.
10. Click Finish.

ﬂ lew Oce Te Project Wizard - Step 1 of 1 *
@ Ocean for Techlog Plug-in Project Details
Please set the aptions of your new plug-in.
Class: | MyFirstPlugin
Vendor Name: | Schlumberger
Support e-mail: | jsmith@slb.com
Crash dump e-mail: | jsmith@slb.com
Description: | This is my first plug-in
Version: 1.0 I
Finish Cancel
Figure 22 Plug-in wizard
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The wizard creates the project with the main plug-in class.

1. Add a new plug-in activity by right-clicking on the project in the Solution Explorer
and selecting Add > New Item in the context menu.

2. In the Item types area, under Visual C++ item type, select Ocean > Techlog
2020.1.

Select the Ocean Activity template.
4. Provide the name “ReadDataActivity” for the activity.
Click Add in the dialog (See Figure 23.)

4 Installed *  Sort by: | Default mi rch (Ctrls o-
4 Visual Ces @ Ocean Activity Visual C++ Type: Visual C++
Code Ocean Activity Wizard 20.1
Formatting 3 Ocean Exporter Visual C++
ATL
Data {F Ocean File Importer
Resource
Web l\jII}E Ocean MIME Importer visual C++ OQcean ACtIVity template
Utility o
Property Sheets @ Ocean Plug-in Domain Object Visual C++
:;H;l Q@ QOcean Test Visual C++
4 Ocean o _ Ocean Item type
Techlog 2018.1 ﬂ Ocean Workstep Activity
Techlog 2018.2
Techlog 2019.1
Techlog 2019.2

Techlog 2020.1 ACtIVIty name

Name: ReadDataActivity /
Location: C\Users\Iguenouxi\source\repos\MyFirstPlugin\MyFirstPlugin, - Browse...

Add Cancel

Figure 23 New activity window
Note: You also have the ability to create:

e An Ocean Exporter. This adds to the project the skeleton code of a plug-in
exporter. See the “Exporter implementation” section in Ocean for Techlog
Developer Guide - Plugin Domain Object - Importer&Exporter for more
information on how to implement a plug-in domain object with Ocean.

¢ An Ocean File Importer. This adds to the project the skeleton code of a
plug-in file importer. See the “FileImporter implementation” section in Ocean
for Techlog Developer Guide - Plugin Domain Object - Importer&Exporter
for more information on how to implement a plug-in domain object with
Ocean.

e An Ocean MIME Importer. This adds to the project the skeleton code of a
plug-in MIME importer. See the “MimeImporter implementation” section in
Ocean for Techlog Developer Guide - Plugin Domain Object -
Importer&Exporter for more information on how to implement a plug-in
domain object with Ocean.
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An Ocean Plug-in Domain Object. This adds to the project the skeleton
code of a plug-in domain object. See the “Plug-in domain object” section in
Ocean for Techlog Developer Guide - Plugin Domain Object -
Importer&Exporter for more information on how to implement a plug-in
domain object with Ocean.

An Ocean Workstep Activity. This adds to the project an activity class that
instantiates a Workstep in the Techlog Application Workflow Interface with
its signals and slots. See the “Workflow and worksteps” section in Ocean for
Techlog Developer Guide — Basics for more information on how to implement
an Ocean workstep.

6. Change the “Tab title”, “Group title”, “Action menu text” and “Action menu tooltip”
fields as appropriate (See Figure 24). These fields are used to create the plug-in
menu in Techlog toolbar that triggers the Ocean activity.

Note:

The wizard allows you to add the plug-in activity to a tab, a group and
optionally a sub-group that are already declared in the plug-in code. Existing
tabs, groups and sub-groups are listed into the corresponding tab, group and
sub-group drop down lists.

7. Click Finish.

1)

| 0] Ocean for Techlog Activity Item Details

| Please set the options of your new activity.

Tab: oﬁirpma new... v
New Tab title: My first plug-in
Group: Q(erma new... hd

MNew Group title: My first group

SubGroup: Not used s
Action menu text:  Read data
Action menu tooltip:  Read data
Action menu icon:  resources\ocean.png

Finish Cancel

Figure 24 New activity wizard

The wizard adds the activity class to the project.
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LN IFIntellisense is disabled in Visual Studio, Ocean template items are not accessible
and an error message is raised. In Tools > Options menu of Visual Studio, Disable
database has to be turned off.

f Cptions — u @é]‘
Search Options (Ctrl+E) P Complete Multiline Comments  True o
4 Text Editor - i
General E
File Extension P o £
b All Languages Disable Database Auto Updates False
b Basic ! Disable Implicit Files False -
B C# i Disable Implicit Cleanup False
a4 C/C++ Disable External Dependencies Fi False
General | 4 Recreate Database False
Scroll Bars Rescan Selution Interval 60
Tabs Disable Navigate To Cache Prele False
Advanced 4 Diagnostic Logging
b Formatting Enable Logging False
View Logging Level 5 I
I CoffeeScript
B CS5 Disable Database
b FE Disable all use of the code browsing database. The database will not be opened or
P HTML il created.
[ oK ] [ Cancel

Figure 25 Disable database
Inspecting the files
The Ocean for Techlog Wizard creates a solution named “MyFirstPlugin” with a project

named “MyFirstPlugin” in the Visual Studio Solution Explorer. The project will contain
header and source file for the P1ugin class that was created, and the Activity class

Solution Explorer
@ o-sa@| ok
Search Solution Explorer (Ctrl+5) 2~

fa] Solution 'MyFirstPlugin’ (1 project)
4[] MyFirstPlugin
[+ =B References
I+ 'z External Dependencies
4 Header Files
b @ MyFirstPluginh €— Plugin header
[8] MyFirstPlugin_precompiled.h
b [4 ReadDatalctivity.h €—
Resource Files

Activity header

™

4 L. Source Files
B+ MyFirstPluginepp €— Plugin source
b ++ ReadDataActivity.cpp €———T Activity source

A TechlogPlugin.props &—————— Plugin project properties

Figure 26 Example project header and source files in Solution Explorer
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Plugin

The main plug-in class derives from PluginIdentity interface class.

PluginIdentity is derived from IPlugin class (plug-in interface) that exposes
these virtual methods:
class IPlugin
{
public:
virtual void getInformation (PluginInformation

&pluginInformation) const = 0;

virtual void getActivities (PluginActivities

&activities) const = 0;

virtual void getMenu (PluginMenu é&menu) const = 0;

}i
Implement the plug-in identity interface to declare:

e Information about the plug-in (getInformation)
e Alist of activities (getActivities)

e Menu items used to trigger those activities (getMenu)

#pragma once
#include "tsdkpluginidentity.h"

class MyFirstPlugin : public PluginIdentity
{
Q OBJECT
Q_PLUGIN_METADATA( IID TSDK_PLUGIN_INTERFACE_ID )
public:
virtual void getInformation(Slb::Ocean::Techlog: :PluginInformation&
pluginInformation)
const override;
virtual void getActivities(Slb::Ocean::Techlog::PluginActivities&
activities)
const override;
virtual void getMenu(Slb::Ocean::Techlog::PluginMenu& menu) const
override;
¥
These three methods must be implemented in the source file that first includes the
plug-in and activity header files and S1b: : Ocean: : Techlog namespace at the
beginning of MyFirstPlugin.cpp file.
#include "tsdkplugininformation.h"
#include "tsdkpluginactivities.h"
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#include "tsdkpluginmenu.h"
#include "tsdkpluginmenutab.h"
#include "tsdkpluginmenuaction.h"
#include "tsdkpluginmenugroup.h"
#include "MyFirstPlugin.h"

// Please include here your activity header files
#include "ReadDataActivity.h"

// #include "Activity.h"
[FFFFRACTIVITIES*INCLUDE*****/

using namespace Slb::Ocean::Techlog;

The getInformation method contains properties which provide information to the
plug-in. These include vendor name, plug-in name, plug-in version, description, release
date, plug-in icon, creator, support email, crash dump email, plug-in license feature
and Techlog license feature dependencies. The contents of getInformation should
look something like:

void MyFirstPlugin::getInformation(PluginInformation& pluginInformation)

const

{
pluginInformation.setVendorName (PLUGIN_VENDOR_NAME);
pluginInformation.setName(PLUGIN_NAME);
pluginInformation.setVersion(PLUGIN_VERSION);
pluginInformation.setDescription("This is my first plug-in");
pluginInformation.setReleaseDate("20/02/2018");
pluginInformation.setIcon(QIcon("ocean.png"));
pluginInformation.setCreator(PLUGIN_VENDOR_NAME);
pluginInformation.setSupportEmail ("jsmith@slb.com");
pluginInformation.setCrashDumpEmail("jsmith@slb.com");

'{'he plug-in property values as PLUGIN_VENDOR_NAME, PLUGIN_NAME and

PLUGIN_VERSION are stored in the TechlogPlugin.props file. This property sheet

contains Techlog plug-in properties stored at the Visual Studio project level. Those
values can be changed directly editing the file.

Note: The plug-in vendor name, name and version values passed to the
setVendorName, setName and setVersion functions of the
PluginInformation class have to match the plug-in structure folder
names VendorName/PluginName/TechlogVersion/PluginVersion/.
If this structure folder is not respected the plug-in is not loaded by the
Techlog module manager.
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B¢ MyFirstPlugin - Microsoft Visual Studio ¥ & Quick Launch (Cr+Q) Pl - O x
File Edit View Project Build Debug Team XML Tools Test Ocean  Analyze Window  Help Sign in B
BN - | B2 ‘ - = | Debug =~ 64 - P Local Windows Debugger v‘ B B = el :

TechlegPlugin.props & X Solution Explorer
<«?xml version="1.8" encoding="utf-8"2> Q| o-% @ ‘ F ;| d
=<Project DefaultTargets="Build"™ TooclsVersion="4.0" xmlnz*
-  «<PropertyGroup Label="TechlogSDKHome" >
<TechlogSDKHome>$( TechlogSDKHome20919_1)</TechlogsDk = [l Selution MyFirstPlugin' (1 project)
</PropertyGroup> 4 % MyFirstPlugin
<ImportGroup> b =B References
<Import Project="TechlogSdkHome.user" Condition="Exi b I Bdternal Dependencies
4 Header Files

<Import Project="%(TechlogSDKHome)\Version.0ATL.prot ks )
</ImportGroup> — 3 MyFirstPlugin.h
Gr. [M MyFirstPlugin_precompiled.h
<PluginNa b [2 ReadDataActivity.h

Resource Files

3

saipadolg

Search Solution Explorer (Ctrl+$) P -

ou ies">
me>MyFirstPlugin</Pluginliame>

<PluginVersion>1.8</PluginVersion>
<VendorName>Schlumberger</Vendorhiame >
<UsingGTests>false</UsingGTestss

Source Files

*+ MyFirstPlugin.cpp

++ ReadDataActivity.cpp
/& TechlogPlugin.props

<TechlogProjectPath»</TechlogProjectPath>»
<! --<QtDir></QtDir><GTestsDir></GTestsDir><TechlogVe
</PropertyGroup>»
<ImportGroup>
<Import Project="TechlogPlugin.props.user™ Conditior
<Import Project="$(TechlogSDKHome)\04TL.props™ Condi
</ImportGroup>
<PropertyGroup Label="MocProperties"”>
<!--<MocIncludeDirectories>PathsToIncludeDirectories
</PropertyGroup>»
</Project>

LN Team.. Prope.. Resou.. MNotifi.

Error List  Breakpoints Find Results1  Find Symbol Results  Package Manager Console  Qutput

Ready Ln15 Col 46 Chag INS 4 Publish a

Figure 27 Ocean plug-in project properties

By right-clicking on the project in the Solution Explorer and selecting Ocean plug-in
properties item in the context menu, Ocean plug-in project property values can be

overriden at the Visual Studio user level through the Ocean plug-in properties di-
alog window.

g-in P — O x
Configuration: | All configurations ko
|| Plug-in settings
Plug-in name MyFirstPlugin "g)
Plug-in version 1.0 e}
| [Vendor name Schlumberger e}
| | Deploy to Techlog
| | TLUSERDIR CAUsers\lguenoux\AppData\Roaming\Schlumberger\Techlog O.
| | Test settings
Techlog project [ O
Version
| | TechlogSDKHome $(TechlogSCKHome2020_1) v O
Techlog version 1
Qt version
Glests version vi4
Qt directory $(TechlogSDKHome)\3rdparty\Qt $(QtVersion) [.]C
Glests directary ~ $(TechlogSDKHome)\3rdparty\Google.Test $(GTestsVersion) [ O

ok || Cancel
Figure 28 Ocean plug-in properties dialog window
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Project property values modified through the Ocean plug-in properties dialog
window doesn’t change the default project property values stored in the Techlog-
Plugin.props file. A new property sheet named TechlogPlugin.props.user is cre-
ated in the project directory that contains those new values.

NE
include
ipch
FESOUTCES
srC
xhd
Ko MyFirstPlugin.sin
|%] MyFirstPluginVC.db
MyFirstPlugin VC.VC.opendb
3 MyFirstPlugin.vexproj
ZH MyFirstPlugin.vcxproj filters
|=| TechlegPlugin.props
4 TechlogPlugin.props.user

Figure 29 Ocean plug-in user property sheet

Property values stored in the TechlogPlugin.props.user file have the highest priority
at the build time. Property values defined at the user level can be rollback to the project

level property values using (e] buttons in the Ocean plug-in properties dialog
window.

Note: The best practice is to share only the TechlogPlugin.props in a source
control common to all members of a team that are collaborating on a plug-in
project development.

In the getActivities method, ReadDataActivity is added to the plug-in ac-
tivity. The wizard had declared for this activity a unique id (GUID) and
ReadDataActivity is identified as unique by its GUID in the list of activities of the

plug-in.

static QString
ReadDataActivityId(QLatinl1String("f1007flelce3477ead7fd91f4e7elb7b"));

void MyFirstPlugin::getActivities(PluginActivities& activities) const

{

// Please fill this method with your activities with lines like this

activities.add( TSDK_ACTIVITY( ReadDataActivity, ReadDataActivitylId ) );
// activities.add(TSDK_ACTIVITY(Activity, actionlId));
[¥FFFHXACTIVITIES*REGISTRATION*PLACE* **** /
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The wizard implements the getMenu method in MyFirstPlugin.cpp; this method is
used to add custom menus to Techlog.

Menu items are used to trigger activities.

The sequence to customize the TBar (Ribbon) is summarized using the P1luginMenu
API exposed with Ocean:

1. PluginMenuTab: create hew menu area for the plug-in
PluginMenuGroup: Nnew menu group created and added to the new
PluginMenuTab object

3. PluginMenuAction: new menu action created and added to the new
PluginMenuGroup Object and instantiated with an action id

4. PluginMenu: New PluginMenuTab object added the Techlog main menu

PluginMenuAction PluginMenuGroup PluginMenuTab PluginMenu
My SOK plugin elloWorld plug ample
K gview ©) s & ¢ 3
[=: Setup Lafvie Setup customplot Snake Chart % Test events 2 0p
52 Setup crossplot {5 Setup waveform Graphics
@ Setup section plot 2d = Imp

[ Update crossplot & Setup crossplot AVA ©)] Star field
Ul

Figure 30 Plug-in menu classes

See the “Plug-in information and menu” section in Ocean for Techlog Developer
Guide - Basics for more information on how to extend Techlog menus.

To link ReadDataActivity with the PluginMenuAction that triggers this activity,
the wizard instantiates the P1uginMenuAction object passing to the constructor the
unique identifier (GUID) of the activity declared at the beginning of MyFirst-
Plugin.cpp.

void MyFirstPlugin::getMenu( PluginMenu& menu ) const

{
PluginMenuTab tab ("63c99cc4e766412d84a7827e3b238a58");

tab.setTitle("My first plug-in");

PluginMenuGroup group ("e7e3b9553d64417283eb7b1083789e96");
group.setTitle("My first group");

PluginMenuAction actionReadData (ReadDataActivityId);
actionReadData.setText("Read data");

group.addAction(actionReadData);

tab.addGroup(group);
menu.addTab(tab);
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Activity

This new action menu triggers the ReadDataActivity. This class inherits from the
AbstractActivity interface class which is the base class for any Ocean for Techlog
plug-in activity.
class AbstractActivity : QObject
{
public:

virtual void run() = 0;

) ;

virtual void dispose(

}i
The run method is the main method of an activity, called when the user clicks on the
corresponding menu item.

Override the dispose method if you need to cleanup resources before the activity is
unloaded.

The AbstractActivity iS a QObject S0 every activity declared in a plug-in is a
QObject, but you need to add a 9 _OBJECT macro in your activity class to tell the
meta-object compiler to compile the signals and slots.

class ReadDataActivity : public Slb::Ocean::Techlog: :AbstractActivity

{
Q_OBJECT;

private:
void run();

P

Writing the algorithm code

Once the skeleton of the plug-in has been created, you need to implement the plug-in
logic that will be triggered when the user clicks on the action menu declared in the
getMenu method of the plug-in identity class (main plug-in class).

You add the custom algorithm code overriding the run method of the Abstrac-
tActivity interface.

#include "ReadDataActivity.h"
using namespace Slb::Ocean::Techlog;

void ReadDataActivity::run()

{
// TODO: Implement the action menu logic here.

}
To write the algorithm code:
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Access the APIs from the S1b: :Ocean: : Techlog nhamespace.
Code the run method. The work for the activity is completed:

Read the current main project using the Session: :current () .mainProject ()
API. The Project class exposes a function wells, which provides navigation to the
well collections in the project. Parse through all the wells and for each well parse
through all the datasets using the datasets public function exposed in the well
class.

Get for each dataset from the corresponding properties exposed in the Dataset class:

e Its name
e Itssize; use the rowCount public method which returns the number of rows of
the dataset (and therefore of all its variables)

Print the well name, dataset name and size from the main Techlog project using
Session: :current() .currentWorkspace () API. The Workspace class ex-
poses the 1logEvent method to print message into Techlog output console with some
different output levels listed in LogLevel enumeration class:

e Debug

e Information
e Warning

e Error

For each dataset parse through all its variables using the variables public function
exposed in the Dataset class.

Get for each variable from the corresponding properties exposed in the variable
class:

e Its name
e Itsunit
o Its family

And print its property values in the Techlog Output console using the 1ogEvent
method of the current Workspace with a LogLevel set to Information.

Call stop method inherited from AbtractActivity interface class at the end of
your activity run method to stop the plug-in activity. Otherwise, the plug-in will stay in
the background until the user manually stops the plug-in task in the workspace
manager of Techlog (Figure 31) or stops Techlog.
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Workspace

Current workspace

4 {@} Tasks
0% myfirstpluginD6d.dll

4 Workspaces .
4 Techlog workspace
Plug-in manager
> m Saved workspaces

1
=
=

Figure 31 Techlog workspace manager

This example shows the complete activity source code:

#include

#include
#include
#include

"ReadDataActivity.h"

"tsdklock.h"
"tsdkloglevel.h"
"tsdkvariableenums.h"

using namespace Slb::Ocean::Techlog;

void ReadDataActivity::run()

{

// TODO: Implement the action menu logic here.

// Lock all
Lock lock = LOCK_CREATE_AND_ACQUIRE_ALL(lock);

// Get the current workspace from the current session

Workspace workspace = Session::current().currentWorkspace();

// Get the main project from the current session

Project proj = Session::current().mainProject();

// Iterate on all the wells in the project
foreach (Well well, proj.wells())

{

// iterate on all the datasets of the current well in the loop
foreach(Dataset dataset, well.datasets())

{

// Get the name and size of the current dataset in the loop

QString datasetName = dataset.name();

QString datasetSize = QString::number(dataset.rowCount());

// Display well name and dataset infos in Techlog output console

workspace.logEvent(LogLevelInformation,
QString("<b>Well name = %1, Dataset name = %2, Dataset size = %3</b>")
.arg(well.name()).arg(datasetName).arg(datasetSize));
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// iterate on all the variables of the current dataset in the loop
foreach(Variable var, dataset.variables())
{
// Get the name, unit and family of the current variable in the loop
QString varName = var.name();
QString varUnit = var.unit();
QString varFamily = var.family();
// Display variable infos in Techlog output console
workspace.logEvent(LogLevelInformation,
QString("Variable name = %1,Variable unit = %2,Variable family = %3")
.arg(varName).arg(varUnit).arg(varFamily));

¥
}

// release objects locked
lock.release();

// Stop the plug-in activity
stop();

Running the plug-in

You have just completed the modification of the run method. In this section, you will
finish building the solution and run your plug-in in Techlog.

Build your solution in Visual Studio in release 64 bit. This creates a new folder for the
plug-in in the deployment folder (Extensions folder) of the Ocean framework. This
plug-in folder contains the new plug-in library. When it starts the module manager
scans the Extensions folder and shows the new library in the list of available
plug-ins. The plug-in menu is added to Techlog when the plug-in is enabled in the
module manager. The activity runs as a separate process when the user clicks on the
action menu; at this moment the plug-in appears as a new task in the list of tasks of the
current workspace of Techlog.

Open the Techlog module manager and enable MyFirstPlugin. My first plug-in
tab is added to the Techlog native tabs. This tab contains only one group My first
group and this group contains only one action menu Read Data (Figure 32).
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Read data

| My first group

Select your license configuration

Ocean
Framework
1)

o oomn.

Ocesn for Techlog Net example plugin
‘.I. Default TestRunnerPlugin

TestRunnerPlugin

Cancel

B Ouput

W
Figure 32 Enable MyFirstPlugin in the module manager

Import the Techlog fundamentals dataset deployed with the Ocean framework
(% TechlogSDKHome % |demo-project) and click on the Read Data action menu. The
Read Data activity shows all the wells, datasets and variables in the Techlog mes-
sage log (Figure 33).

Note: O'pe'nin'g a 'I:echldg brdjef:t with an Ocean framework license will taint the

project.

Stud Drilling e My first plug-in

[17:36] Well name = Well4, Dataset name = MIC, Dataset size = 3
[17:36] Variable name = CDEPTH, Veriable unit = ft Variable family = Core Depth

[17:36] Veriable name = CPERM,Variable unit = mD,Variable family = Core Permeability

[17:36] Variable name = CPHI Variable unit = v/yVariable family = Core Porosity

[17:36] Variable name = CShg,Variable unit = v/y;Variable family = Core Mercury Saturation (Array)
[17:36] Variable name = DEPTH,Variable unit = ft Variable family = Measured Depth

117:36] Variable name = PC_Lab; Variable unit = bar Variable family = Capillary Pressure Laboratory (Array)
[17:36] Variable name = SamplelDVariable unit = unitless,Variable family =

[17:36] Well name = Well4, Dataset name = STRATIGRAPHY, Dataset size = 6

[17:36] Variable name = MD.Variable unit = ft Variable family = Measured Depth

[17:36] Veriable name = ZONE_NAME Veriable unit = Variable family = Zone Name

[17:36] Wellname = Well4, Dataset name = SURVEY, Dataset size = 74

[17:36] Variable name = AZIVariable unit = deg,ariable family = Hole Azimuth

[17:36] Variable name = INCLINATION, Varizble unit = deg,Variable family = Hole Deviation

[17:36] Variable name = MD,Variable unit = ft Variable family = Measured Depth

[17:36] Well name = Well4, Dataset name = TL WellPath, Dataset size = 17847

[17:36] Variable name = BOREHOLE_AZIMUTH,Variable unit = dega,Variable family = Hole Azimuth
[17:36] Variable name = BOREHOLE_DEVIATION Veriable unit = dega,Variable family = Hole Deviation
[17:36] Variable name = DL Variable unit = dega/L00ft Variable family = Dog Leg Severity

[17:36] Variable name = MD,Variable unit = ft Variable family = Measured Depth

[17:36] Variable name = THL,Variable unit = ft, Variable family = True Horizental Length

[17:36] Variable name = TVD Variable unit = ft Variable family = True Vertical Depth

[17:36] Variable name = TVDBML Variable unit = ft Variable family = True Vertical Depth Below Mudline
[17:36] Variable name = TVDSS Variable unit = ft Variable family = True Vertical Depth Sub Sea

117:36] Variable name = XOFFSET Varicble unit = ft Variable family = X Offsct

[17:36] Veriable name = YOFFSET Variable unit = ft Variable famil
[17:36] Wellname = Well9, Dataset name = DATAFULL, Dataset size = 1601

[17:36] Variable name = A,Variable unit = ,Variable family =

117:36] Variable name = AT10, Variable unit = OHMM,Variable famity = Medium Resistivity

117:36] Variable name = AT20,Variable unit = QHMM,Vzriable family = Array Resistivity

117:36] Variable name = AT30,Variable unit = OHMM Variable family = Array Resistivity

117:36] Veriable name = AT60, Variable unit = OHMM,Variable family = Array Resistivity

[17:36] Variable name = AT90,Variable unit = OHMM,Variable family = Deep Resistivity

[17:36] Veriable name = BAD_HOLE Variable unit = Variable family = Bad Hole Flag

[17:36] Variable name = BHT_DK Variable unit = DEGF Variable family = Bottom Hole Temperature

[17:36] Variable name = Bound Water_QE,Varizble unit = v/, Variable family = Bound Water Volume Fraction
117:36] Variable name = B5_DK,Variable unit = IN Variable family = Bit Size

117:36] Variable name = C_PHLVariable unit = Variable family = Core Porosity

117:36] Variable name = CALC_EQ Variable unit = FLAG Variable family = Caliper

[17:36] Veriable name = CALL Variable unit = IN Variable family = Caliper

[17:36] Veriable name = CKX200,Varizble nit = MD Variable family = Core Permeability

[17:36] Variable name = CKX200_CVariable unit = MD,Variable family = Core Permeability
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Figure 33 Read Data activity ouput messages

You have now written, built, and run your first Ocean for Techlog plug-in.

Debug the plug-in

To debug the plug-in you have to build it in debug mode. Go to the Visual Studio
solution and change the build mode from release x64 to debug x64. Still in Visual Studio
open the ReadDataActivity.cpp file and into the run method of the activity add a
breakpoint on the first line.

Re-build the solution, close and reopen Techlog.

A new library called MyFirstPlugin64D.dll is generated in the plug-in folder. Then
go back to Techlog, open the module manager and refresh the plug-in list (right click on
Ocean plug-ins). The new plug-in for debugging appears in the module manager in
the Ocean plug-ins. Disable the release version and enable the debug one.

Select your license configuration

Techlog Modules
4[| Oceanplu *

Refresh all availabilities

Ocean "
O] % Ge
Framework T Refresh plug-in list
07 4[] Ocean
o @ Expand All
O Collapse All
& Default [ @ myPlugin

|:| Ccean for Techlog Met example plugin
D TestRunnerPlugin
D TestRunnerPlugin
[T] ¥+ WorkflowEngineDemoFlugin

Start | | Cancel

Figure 34 Refresh plug-in list

Press the Ctrl+Alt keys and click on the Read Data action menu. The Visual
Studio Just-In-Time debugger pops up and asks you to select from the list a
Visual Studio solution debugger to attach to the plug-in host, which for a plug-in built in
64 bit is techlogpluginhost64D.exe. Select MyFirstPlugin in the list and click
Yes as shown in Figure 35.
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|

Manually choose the debuggng engnes.

D0 you want to debug using the selected debugger?

Yes o

Figure 35 Debug the plug-in

The debugger stops on the first line of the run activity method where the breakpoint
has been added.

If Visual Studio complains about a Managed application please Manually choose
the debugging engines turning on this option in the Visual Studio Just-In-Time
debugger window. A popup shows up listing all the available debugger engines,
enable the Managed debugger for which version of the .NET framework you want to
debug. Unless you're debugging a .NET based plug-in, you can not attach the
.NET/Managed debugger at all.

-

-
Aftach to Process ﬁ

[7876] D:\Software\Techlog\Techlog 2016 1\Techlog 2016.1 Alpl

Choose the types of code to debug:
[] Managed (v3.5, v3.0, v2.0)

Mative
[ 7-sqL
[ Managed Compatibility Mode

The following code will be debugged:

Mative

Figure 36 Visual Studio debugger engines
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Auto enabled the plug-in

Enable the plug-in at Techlog start-up by adding a file named auto_enabled (no
extension) into the plug-in folder that contains the plug-in dll.

—

L

d b « MyFirstPlugin » 20201 » 1.0

Extenzions
Schlumberger
GenericFilestorage
HelloWorld
MyFirstPlugin
2020.1
1.0

MyPlugin

" auto_enabled
MyFirstPlugin.dll
& ocean.png
W

Figure 37 auto_enabled file

v O

This file is a flag that tells Techlog to enable the plug-in in the Techlog module
manager. The auto enabled plug-in no longer appears in the module manager under
the Ocean plug-ins node and all the plug-in menus are added automatically to the
Techlog ribbon when Techlog starts.

Select your license configuration

L+
L

Ocean
Framework

(1)

Default

Techlog Modules

v [ ] Ocean plug-ins

O E GenericFileStorage
v [ Ocean examples
O @ velloword
O @ reloword
O MyPlugin
[7] Ocean for Techlog .Net example plugin
[ TestRunnerPlugin
[ TestRunnerplugin

[ #P workflowEngineDemoPlugin

OK | Cancel ‘

Figure 38 auto enabled plug-in not visible in module manager
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Note: The Techlog plug-in host process on which the auto enabled plug-in runs
doesn’t appear anymore in the list of processes of the Windows task
manager.

Auto start plug-in activities

A file named plugin_config.json deployed to the plug-in folder allows to run a list of
plug-in activities at the Techlog startup .

The JSON file contains two parameters:
« AutoStartActivies that allows to pass the list of activity ids to be run
« auto_enabled that tells Techlog to enable the plug-in at the Techlog startup
{
"AutoStartActivities" : ["vshgr","workstep by zone"],

"auto enabled" : "true"

Techlog Viewer plug-in development (Schlumberger Internal only)

The Techlog Viewer is software to facilitate display and interaction with data.
Techlog Viewer specific

To allow vyour plug-in to run on Techlog Viewer, call the
setTechlogViewerActivity function in the PluginInformation class, with
the activity ID as the parameter.
class PluginInformation

{
public:

void setTechlogViewerActivity (const QString
&techlogViewerActivity)
bi
This is an example:
static QString
ReadDataActivityId(QLatinlString("f1007fle-1ce3-477e-a47f-d91f4e7elb7b
"))

void MyFirstPlugin::getInformation(PluginInformation& pluginInformation)
const

{
pluginInformation.setTechlogViewerActivity(ReadDataActivityId);

}

Note: Techlog Viewer is single well by design; developing a plug-in that uses
several wells will result in an assert being displayed in the Techlog Viewer
output window.
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Signed plug-ins

Having a signature on the plug-in is not necessary for internal development only.
However a .sign file is mandatory if any external deployment is planned.

To generate the signature file, please contact the Techlog Platform Product Champion
- ERivollier@slb.com -

Create unit tests for your plug-in

By exposing a couple of basic concepts, Ocean for Techlog enables plug-in developers
to write and run automated tests using their unit testing framework of choice while still
giving the unit tests access to the full functionality of Ocean for Techlog. The tutorial
“Unit Testing Techlog Plug-ins” in the OceanForTechlog.chm file shipped with the
Ocean package outlines how to get started and how to integrate the tests into a
continuous integration environment.

Please refer to this tutorial for more details on how to create unit tests with Ocean for
Techlog.
Creating a Test plug-in with Visual Studio

To create a Test plug-in project using Visual Studio:

Add a new test plug-in project to the solution that contains an Ocean plug-in project by
right clicking on the solution in the Solution Explorer and selecting Add > New
Project in the context menu. In the Project types area, under Visual C++ project
type, select Ocean > Techlog 2020.1. Then select the Ocean Test Plug-in
template.

Note: A test project cannot be created in an empty Visual Studio solution. The test
project wizard uses the main plug-in project in the solution.

Provide the name “TestMyFirstPlugin” for the project. Click OK to start the Wizard (see
Figure 39).
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P Recent = sort by: | Default ~| & ear tr P~

o TEEIEE @ Ocean Plug-in Visual C++ Type: Visual C+4
4 Visual C++ - Create Ocean test plug-in for Techlog
Windows Desktop Ocean Plug-in Installer Visual C++ 2020.1
b Cross Platform @ _ )
MFC/ATL 'ﬂ Ocean Test Plug-in Visual C++
CLR
Test
Other
4 Ocean Ocean Test Plug-in template
Techlog 2018.1
Techlog 2018.2
Techlog 2019.1

Techlog 2019.2 </ Ocean Project type
Techlog 2020.1 -

Not finding what you are locking for?

Open Visual Studio Installer / PI‘O]eCt name
Name: TestMyFirstPlugin

| Location: C:\Users\lguenoux\source\repos\MyFirstPlugin - Browse...

oK Cancel
Figure 39 New project window

The test plug-in wizard opens (see Figure 40).
Set these inputs:

Class: test plug-in class name

Vendor name: the name of the plug-in owner

Version: the plug-in version

Techlog project: the Techlog project data that you want to use to run your
unit tests. It is an optional input. If you don't specify any Techlog project, tests
will be run in Techlog with a temporary project.

¢ Main project: select the Ocean plug-in in the solution that you want to test.
The Ocean plug-in will be a dependent library of the Test plug-in.

Click Finish in the dialog.
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39_] Mew Ocean for Techlog Plug-in Test Project Wizard - Step 1 of 1 >

ol Ocean for Techlog Plug-in Test Project Details

Please set the options of your new Test Project.
Class: | TestMyFirstPlugin

Vendor Name:  |Schlumberger]

Version: 1.0

Techlog project:

Plug-in project: | MyFirstPlugin

Finish Cancel

Figure 40 Test Plug-in wizard

Note: The path to the “3rdparty” folder of the Ocean package that contains
Google test libraries (debug and release folders) and header files (include
folder) is added to the project by the wizard.

See the “Techlog Test Adapter” section on page 50 for more information on how to
access and modify test settings and run plug-in unit tests with the Techlog Test
Adapter.

Inspecting the files
The Ocean Test Plug-in Wizard adds a project named “TestMyFirstPlugin” in the Visual

Studio Solution Explorer. The project contains header and source file for the Test Plugin
class that was created, and the test activity and runner classes (see Figure 41.)
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Implement the tests

Solution Explorer
@ e-ea@m|l &= a4
Search Solution Explorer (Ctri+5)

fad Solution 'MyFirstPlugin' (2 projects)
4 [%] MyFirstPlugin
B om External Dependencies

B o Header Files
o Resource Files
B Source Files

4 [A TestMyFirstPlugin (Visual Studic 2010)
o5 External Dependencies

P Header Files /
B TestMyFirstPluginh

B TestMyFirstPlugin_precompiled.h
B TestMyFirstPluginActivityltern.h
B TestMyFirstPluginGTestRunnerh € Test Runner header

B TestMyFirstPluginTests.h €——0___  gooale tests header
4 Resource Files

Test Plugin header

-+

Test Activity header

=

4 Source Files

*+ TestExports.cpp

*++ TestMyFirstPlugin.cpp /
++ TestMyFirstPluginActivityltem.cpp €

+4 TestMyFirstPluginGTestRunner.cpp &——— Test Runner source
+4 TestMyFirstPluginTests.cpp €=—————{__ Google tests source

Test Plugin source

Test Activity source

v W v VW 4

Figure 41 Test plug-in header and source files in Solution Explorer

The Test Activity runs all the Google tests implemented in the Test plug-in through the
Test runner utility class.

The Google test API provides a number of options you may consider depending on your
requirements. Refer to the official Google test online documentation at
http.//code.google.com/p/googletest/.

In TestMyFirstPluginTests.cpp file, there are two types of Google tests created by
the wizard.

The first one uses the TEST macro to define the test.

TEST has two parameters: the test case name and the test name. After using the
macro, define your test logic between a pair of braces. Use a bunch of macros to
indicate the success or failure of a test.

In this example, the test creates a well in Techlog project, sets its color property to blue
and checks if the color is correctly set.

TEST(GTestNamel, OkTest)

{
Lock lock = LOCK_CREATE_AND_ACQUIRE_ALL(lock);

Project project = Session::current().mainProject();
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Well well = Well::create("MyWell", project);
Droid wellDroid = well.droid();
well.setColor(Qt::blue);

lock.release();

lock
well

LOCK_CREATE_THEN_ACQUIRE_OR_RETURN(lock, wellDroid);
DomainObject::get(wellDroid).tryCast<Well>();

if (well.isNull())

{
ASSERT_FALSE (well.isNull());
lock.release();
return;

EXPECT_EQ(well.color(), Qt::blue);
lock.release();

lock = LOCK_CREATE_AND_ACQUIRE_ALL(lock);
well.erase();
lock.release();

}
The second one uses the TEST _F macro that defines a Google test fixture.

A test fixture is a place to hold objects and functions shared by all tests in a test case.
Using a test fixture avoids duplicating the test code necessary to initialize and cleanup
those common objects for each test. It is also useful for defining commonly used
sub-routines that your tests may need.

In this example “MyWell” is initialized in SetUp method called before the test is run.
Check in the test fixture if the color of “MyWell” is blue. "MyWell” is erased in
TearDown method called after the test is run.

void TestMyFirstPluginTest::SetUp()

{
Lock lock = LOCK_CREATE_AND_ACQUIRE_ALL (lock);
Project project = Session::current().mainProject();
Well well = Well::create("MyWell", project);
well.setColor(Qt::blue);
lock.release();

void TestMyFirstPluginTest::TearDown()

{
Lock lock = LOCK_CREATE_AND_ ACQUIRE_ALL(lock);
Project project = Session::current().mainProject();
Well well = project.wells().get("MyWell");
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well.erase();
lock.release();

TEST_F(TestMyFirstPluginTest, WellColor)

{
Lock lock = LOCK_CREATE_AND ACQUIRE_ALL(lock);

Project project = Session::current().mainProject();
Well well = project.wells().get("MyWell");

if (well.isNull())

{
ASSERT_FALSE(well.isNull());

lock.release();
return;

EXPECT_EQ(well.color(), Qt::blue);

lock.release();
}

The Ocean test plug-in project is created in a Visual Studio solution that already hosts
an Ocean plug-in project to allow the developer to make calls to the Ocean plug-in
methods in Google tests.

In this example, ReadDataActivity of MyFirstPlugin has a public method to
remove from a Techlog variable all the missing values. Test this plug-in functionality
by calling it from a Google test in my test plug-in.

Variable ReadDataActivity::removeMissingValues(Variable variable)

{
Lock lock = LOCK_CREATE_AND_ACQUIRE_ALL(lock);

Dataset dataset = variable.dataset();
Well well = dataset.well();

Variable ref = dataset.findReferenceVariable();

QVector<float> resultVarValues;
QVector<float> resultRefValues;

int rowCount = variable.rowCount();

for (int i = @; i < rowCount; i++)

{
if (variable.getFloatValue(i) != Absent::MissingValue)

{
resultVarValues.append(variable.getFloatValue(i));
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resultRefValues.append(ref.getFloatValue(i));

Dataset resultDataset =
Dataset::create(QString("%1_result").arg(dataset.name()),
ref.name(), ref.format(), resultVarValues.count(), well);

Variable resultRef = resultDataset.findReferenceVariable();
resultRef.setFamily(ref.family());
resultRef.setUnit(ref.unit());
resultRef.setFloatValues(resultRefValues);

Variable resultVar =
Variable::create(variable.name(), resultDataset,
variable.format(), VariableTypeContinuous, 1);
resultVar.setFamily(variable.family());
resultVar.setUnit(variable.unit());
resultVar.setFloatValues(resultVarValues);

lock.release();

return resultVar;
}

The first thing to do is to export the ReadDataActivity class when MyFirstPlugin
is built and import ReadDataActivity class when TestMyFirstPlugin is built. Do
this by adding a conditional compilation tag in C/C++ > Preprocessor >
Preprocessor Definitions to MyFirstPlugin project settings (see figure 42).
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GettingStarted Property Pages ?| =

Configuration: | Active(Debug) +| Platform: |Active(sa) v] | Configuration Manager... |
b Common Properties Preprocessor Definitions WIN32; DEBUG; WINDOWS;_USRDLL;WIN32PROJECTS_EXPORTS;PLUGIN_VENDOF
4 Configuration Properties Undlefine Preprocessar Definitions

Szad Undefine| preprocessar Definitions M
Ocean for Techlog Ignore 5t
Debugging Preproceq | WIN32
VC++ Directories Preproced | -DEBUG
4 CICe+ WINDOWS

Keep Con iuSRDLL
WIN32PROJECTS_EXPORTS
PLUGIN_VENDOR_NAME="$(VendorName)”
Preprocessor PLUGIN_VERSIOM="8(PluginVersicn)"
Code Generation B B DAARIES"SBLuginName)"
Language
Precompiled Headers
Output Files
Browse Information Inherited values:
Advanced
All Options
Command Line
I Linker
I Manifest Tool
I XML Document Generator
b Browse Information
b Build Events i
b Custom Build Step

b Code Analysis [¥] Inherit from parent or project defaults
Preprocessof||

General
Optimization

Figure 42 Add conditional compilation tag in Ocean plug-in settings

Then in ReadDataActivity header file, add this code:
#ifdef T_BUILDING_ACTIVITY

#  define D1lExport _ declspec( dllexport )
ttelse

#  define D1lExport _ declspec( dllimport)

#tendif

class D11Export ReadDataActivity : public
Slb::0cean::Techlog: :AbstractActivity

{
Q_OBJECT;

private:
void run();

public:
Slb::0cean::Techlog::Variable
removeMissingValues(Slb::Ocean::Techlog::Variable variable);
s
The removeMissingValues function is imported by the Test plug-in; call it in a
Google test.

TEST_F(TestMyFirstPluginTest, RemoveMissingValues)
{
Lock lock = LOCK_CREATE_AND_ACQUIRE_ALL (lock);

Project project = Session::current().mainProject();
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Variable variable =
project.wells().get("Welll").datasets().get("DATAFULL").
variables().get("GR");

lock.release();

ReadDataActivity *readDataActivity = new ReadDataActivity();
Variable resultVar = readDataActivity->removeMissingValues(variable);

lock = LOCK_CREATE_THEN_ACQUIRE_OR_RETURN(lock, resultVar);

for (int i = @; i < resultVar.rowCount(); i++)

{
if (resultVar.getDoubleValue(i) == Absent::MissingValue)

{
ASSERT_FALSE(true);

lock.release();
return;

ASSERT_TRUE (true);

lock.release();
}
In TearDown function the result dataset is erased after the test.

void TestMyFirstPluginTest::TearDown()

{
Lock lockl = LOCK_CREATE_AND_ACQUIRE_ALL (lock1);
Dataset dataset =
Session::current().mainProject().wells().get("Welll").datasets().
find("DATAFULL_result");

if (!dataset.isNull())
dataset.erase();
lockl.release();

Note: The test fixture TestWorkstep created by the Ocean Test plug-in wizard
shows how to test AWI workstep method, waiting for the end of the
processing in order to assert the results.
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Run the tests
Once the solution is built MyFirstPlugin and TestMyFirstPlugin are listed by the
Techlog module manager.
Open the module manager, refresh the list of plug-ins and enable TestMyFirstPlugin.

Select your license configuration

Techlog Modules

v [W] Ocean plug-ins

Fraor:z\?vr;rk | % GenericFileStorage
anm v [ ocean examples
(+] O @ reloworld
O @ teloword
L Default 1 MyPlugin

[ ocean for Techlog .Net example plugin
TestMyFirstPlugin
|:| TestRunnerPlugin
| TestRunnerPlugin

1 WorkflowEngineDemoPlugin

oK | | Cancel

Figure 43 Enable test plug-in

GTest tab is added to the Techlog menus that contain a gTest action item from which
the test are run in the Techlog context. When the tests have finished running, the user
opens the result tests log file directly from the Techlog output console (see figure 44).
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Data  Utlity  Studio  Petrophysics  Geology  Geomechanics  Driling  Reservoir  Geophysics  Unconventionals  [ERGIIS m

gTest

Gtest
Project browser 5omo=

Y Er— ‘ :
" TestMyFirstPlugin.dl

Y. U® Fie g Forms vew- bl
] a [- Running 4 tests from 2 test cases.
[ 4 [E[ &[] 4 Global test environment set-up.
fundamentals_16_1_untainted - —-] 1 test from GTestNamel
. [8) quant! GTestNamel.okTest
Q GTestnamel.okTest (28 ms)
> b mywel{b769765-2bb1-42 --1 1 test from GTestnamel (28 ms total)
> b wen [~-———-==-] 3 tests from TestMyFirstpluginTest
> A well2 TestMyFirstpluginTest.wellcolor

TestMyFirstPluginTest.wellcolor (59 ms)
TestMyFirstPluginTest. RemoveMissingvalues
TestMyFirstPluginTest.Removemissingvalues (161 ms)

Workspace s 3 ox TestMyFirstPluginTest. Testworkstep
[ TestMyFirstPluginTest. TestwWorkstep (1009 ms)
Current workspace e 3 tesTs from TestMyFirstPluginTest (1229 ms total)

&2 Tasks Global test enviromment tear-down
4 ) Workspaces 4 tests from 2 test cases ran. (1257 ms total)

PASSED 4 tests.
Techiog workspace [ ] ests
> [ Saved workspaces

Output

o [2016-02-25 18:26] The varigiife mywell(b7f69765-2bb1-42e2-982b-37f3681c1d5e}. mydataset.outputAbyB was created successfully
@  12016-022518:26]  Workijdy execution time: 04332135 (MyWorflow)
@ 016022518261 Resuitfils

Work..] Zon..] Prop.] M..] Co..] Pa..

Figure 44 Gtest plug-in runs in Techlog context

You can also run the tests directly from Visual Studio through the Techlog Test Adapter.

See the “Techlog Test Adapter” section on page 50 for more information on how to run
plug-in unit tests with the Techlog Test Adapter.

Techlog Test Adapter

Ocean plug-in tests can be run directly from Visual Studio development environment in
the Techlog context using the Techlog Test Adapter. The aim of this chapter is to
describe Techlog Test Adapter functionalities and what are different options offer to the
plug-in developer to run Ocean plug-in tests through the Techlog Test Adapter directly
into the Visual Studio development environment or on a build agent as VSTS or
TeamCity.

Discover tests in Techlog Test Adapter
Once Google tests are implemented in the Ocean test plug-in, tests can be discovered

by the Techlog Test Adapter and displayed in the Visual Studio Test Explorer as follow:

1) Set the Default Processor Architecture option to “"x64” in TEST > Test
Settings > Default Processor Architecture menu

2) Open the Visual Studio Test Explorer window from the TEST > Windows menu
3) Build the Visual Studio solution
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Figure 45 Tests in Test Explorer
Run tests with Techlog

When tests are run from the Visual Studio Test Explorer, the Techlog Test Adapter has
now the capability to start Techlog to run plug-in unit tests in the Techlog context with
some Techlog data. This only happens if the Techlog Autorun option is enabled in the
Ocean > Techlog Test Adapter menu.

Ocean | Analyze Window Help
@ Ocean Start Page
Upgrade Ocean for Techlog Project
Upgrade Ocean for Petrel Projects
D Register
Help 3
Ocean Quality Assistant

Techleg Test Adapter 4 Verbose Made
Dependency Resolver
Techleg Autorun

Techlog Version 2

Figure 46 Techlog Autorun option

1) Techlog version

Through the Techlog Version option in the Ocean > Techlog Test Adapter menu

the plug-in developer has the ability to control against which version of Techlog tests

have to be run.

Note:  Techlog version older than 2016.2 aren’t supported by Techlog Test
Adapter.
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Ocean | Analyze Window  Help
® Ocean Start Page
Upgrade Ocean for Techlog Project
Upgrade Ocean for Petrel Projects
D Register
Help r
Ocean Quality Assistant
Techlog Test Adapter r

Verbose Mode
+"  Dependency Resolver
+'  Techlog Autorun

Techlog Version

Auto
20181 Alpha 8
2017.2
20171
2016.2

Figure 47 Techlog Version option

By default, the Techlog Version is set to “Auto”. This means that the Techlog Test

Adapter tries to find by itself the appropriate Techlog version to run Ocean plug-in

tests. The Techlog version auto detection is done through properties that can be set to

the Visual Studio solution at different priority levels.

Note: Techlog Test Adapter starts the Techlog with the right version, run the
Ocean plug-in tests and close Techlog when all tests have been run.

5N Ocean tests are run in Techlog through the TestRunnerPlugin that is shipped in
debug and release modes with the Ocean framework. If one of these plug-ins is ac-
tivated and saved in a favorite Techlog profile, then Techlog Test Adapter wouldn’t be
able to enable the right TestRunnerPlugin at the Techlog start and run Ocean tests.
So please don't activate by default a TestRunnerPlugin in your favorite Techlog
profile.

’N&chlag 2020 - License selection I#
Seh&@ur license configuration

\ @ » [@ Techlog Modules

4 Ocean plug-ins

Techlog ““h"’? [[] #f Depthshift
0/10) (0/10 [7] ¥ GenericFijetorage
[ Y —— 7] @) wmyejpstPiugin
* D Oy examples
& Default estRunnerflugin
D TestRunnerPlugin
&L My Profile P~ | [7] ¥ WorkflowEngineDemoPlugin
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The Techlog Test Adapter is looking first to a .runsettings file set to the Visual Studio
solution. A .runsettings file is an XML file that tells the Techlog Test Adapter to run a
Test plug-in dll with a given Techlog version and project. The expected format is shown
below:

<?xml version="1.0" encoding="utf-8"?>
<RunSettings>
<RunConfiguration>
<TargetPlatform>x64</TargetPlatform>
</RunConfiguration>
<OceanSdk>
<Techlog>
<TestAdapter>
<TestAssembly Name="TestMyFirstPlugin.d1l1l"
TechlogProjectPath="C:/Techlog-Projects/fundamentals_19 1.tlp"
TechlogVersion="2019.1"/>
<TestAssembly Name="TestMyFirstPlugin2.d11l"
TechlogProjectPath="C:/Techlog-Projects/fundamentals_18_1.tlp"
TechlogVersion="2018.1"/>
</TestAdapter>
</Techlog>
</0OceanSdk>
</RunSettings>

Figure 48 .runsettings file example

Note: The file name doesn’t matter, provided you use the extension
“.runsettings”.

The .runsettings file is added to the Visual Studio solution through the Test Settings
> Select Test Settings File menu item.

Test | Ocean  Analyze  Window  Help

Run ¥ pws Debugger » | 2% _

Debug r

Playlist L

Test Settings P | DAsamples\TestAdapterPlugin_18_1\techlog.runsettings
Windows P | L} Select Test Settings File

Default Processor Architecture 4

v Keep Test Execution Engine Running

Figure 49 Add .runsettings file to the Visual Studio solution

The second place where the Techlog Test Adapter searches for Techlog version and
project path to run Ocean plug-in tests is at the Test plug-in project properties level.
From the Ocean plug-in properties dialog window you can define the Techlog
project path. The Techlog version can't be modified through the Ocean plug-in
properties dialog window as it is defined by into an Ocean for Techlog property sheet
deployed with the Ocean framework.

See the “Ocean for Techlog property sheets” section on page 16 for more information
on Ocean properties related to the Techlog version.
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2) Code coverage

r Ocean plug-in properties I\E‘Elgﬁ
Configuration: [ All configurations ']
Plug-in settings
Plug-in name TesthMyFirstPlugin )
Plug-in version 10 G
Vendor name Schlumberger o I
Deploy to Techlog
TLUSERDIR CA\Users\iguenou\AppData\Roaming\SchlumbergeriTechlog |_| o
Test settings
Techlog project  C:\Techlog-Projects\fundamentals_18_1.tlp ] E] |§|
Version
TechlogSDKkHome $(TechlogSDKHome2019_1) -]
echlog version  2018.1 ‘[
Qt version 581
GTests version 16.0
Qt directory $(TechlogSDKHome)\3rdparty\S(PlatformToolset\Qt $(QtVersion) |:| O
GTests directory  ${TechlogSDKHome}\3rdparty\$ (PlatformToolset)\Google. Test $(GTestsVersion) |:| o

| || cancel |[ Apply |

)

Note:

Figure 50 Test plug-in project properties

Techlog Test Adapter.

Ocean | Analyze Window  Help
® Ocean Start Page

Upgrade Ocean for Techlog Project

Through the Code Coverage option in the Ocean > Techlog Test Adapter menu
the plug-in developer has the ability to enable / disable the code coverage of plug-in
unit tests. This option is available in Visual Studio Enterprise only and it is disabled by
default.

Do not use Visual Studio native code coverage. This isnt compatible with

D Register

Help 3
- i : Irces Latest news
M Ocean Cuality Assistant

Techlog Test Adapter ] Verbose Mode

{J Code Coverage ]

«  Dependency Resolver
«"  Techloeg Autorun

Techlog Version L

Figure 51 Code Coverage option
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The Techlog Test Adapter produces at the end of the unit testing a .coverage file that
contains detailed results on the plug-in code covered by the unit tests.
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In order to get the Techlog Test Adapter code coverage running properly in Visual
Studio, you have to set the Profile property to “Yes” in the project Properties >
Linker > Advanced property page.

=
TestMyFirstPlugin Property Pages

2 [ |

Configuration: Platform:  |x64

4 Configuration Properties  +
General
Ocean for Techlog
Debugging
VC++ Directories

b C/Cr+

4 Linker
General
Input
Manifest File
Debugging
System

m,

Optimization
Embedded IDL
Windows Metadata
All Options
Command Line

I Manifest Tool

> XML Document Genera

I» Browse Information

I> Build Events

I Custom Build Step i

<[ I r

'] [ Configuration Manager... ]

Entry Point

Mo Entry Point

Set Checksum

Base Address

Randomized Base Address
Fixed Base Address

Diata Execution Prevention (DEP)
Turn Off Assembly Generation
Unload delay loaded DLL
MNobind delay loaded DLL
Import Library

Merge Sections

Target Machine

-
Ne
Ne

Yes (/DYNAMICBASE)

Yes (/NXCOMPAT)
Ne

m,

S{0utDinS(TargetName).lib

MachineXb4 (/MACHIME: X64)

| Profile |Yes (/PROFILE) |
" CLR Thread Attribute [
CLRImage Type Default image type
Key File

Key Container

Delay Sign

CLR Unmanaged Code Check
Entry Point

The /ENTRY option specifies an entry point function as the starting address for an .exe file or DLL.

Figure 52 Profile property

The .coverage file is read by Visual Studio and displayed into the Code Coverage

Results window.

Code Coverage Results
CodeCoveragel.coverage

Hierarchy

P e | FIX

.=

Not Covered (% Blocks) Covered (Blocks) Covered (% Blocks)

#z OceanPluginTest] PluginTest TestWorkstep Test:T...

Code Coverage Results

Figure 53 Code Coverage results in Visual Studio

3) Others Techlog Test Adapter options

Not Covered (Blocks)
4 Z CodeCoveragel.coverage 11230
OceanPluginTest1.dll 12341

I *z GTestMamel_OkTest_Test 18

I %z Global Functions 4369

I %z OceanPluginTest]_Plugin 145

P %3 OceanPluginTest!_PluginActivityltem 113

B %3 OceanPluginTest] PluginGTestRunner 17

%3 OceanPluginTest]_PluginTest 103

b %3 OceanPluginTest]_PluginTest_FailingTest_Test 4

b %3 OceanPluginTest1_PluginTest_TestWorkstep_Test 202

13

i

64.38% 6828 35.62%
64.38% 6828 35.62%
60.00% 12 40.00%
76.06% 1375 23.94%
100.00% 0 0.00%

100.00% 0 0.00%

100.00% 0 0.00%

42.92% 137 57.08%
13.33% 26 86.67%
45.20% 244 54.71%
14.29% & 85.71%

Property Description
Dependency When the Dependency Resolver option is enabled, the
Resolver missing plug-in dependencies are copied to test as-

sembly folder before running tests.

Enable by default.
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Verbose Mode The Verbose Mode is an option that when is enabled
provides additional details in the Test output console of
Visual Studio as to what the Techlog Test Adapter is
doing.

Figure 54 Other Techlog Test Adapter options

Setup Techlog Test Adapter on a build agent

Through the Techlog Test Adapter you have the ability to run plug-in tests on a build
agent as VSTS or TeamCity. This way you can setup a continuous integration
environment for your plug-in through a build agent that is responsible to:

1) Build the plug-in solution

2) Run the unit tests associated to the plug-in through the Techlog Test Adapter
a. With a targeted Techlog version
b. With a targeted Techlog project or a temporary project

3) Get the plug-in code covered by unit tests through a summary XML file

The coverage summary XML file format is shown below:

<?xml version="1.0"?>

<CoverageReadResult xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"

xmlns:xsd="http://www.w3.0rg/2001/XMLSchema" >
<FullCoveredMethodsNumber>2021</FullCoveredMethodsNumber>
<TotalMethodsNumber>5284</TotalMethodsNumber>
<MethodCoveredLines>5519</MethodCoveredLines>
<MethodNotCovaredLines>12905</MethodNotCovaredLines>
<BlockCovered»10815</BlockCovered>
<BlockNotCovered>»27731</BlockNotCovered>

</CoverageReadResult>

Figure 55 Code coverage XML format

1) Techlog Test Adapter environment variables

In order to configure the build agent with all Techlog Test Adapter options describe
previously in this document for the Visual Studio environment, the Techlog Test
Adapter provides environment variables listed in the table below:

Variable Short description
TLVERBOSEMODE “Verbose Mode” option in the Visual Stu-
dio menu.
Default value: “False”
TLCODECOVERAGE “Code Coverage” option in the Visual

Studio menu.

Default value: “False”

Remark: Only available if Visual Studio
Enterprise is installed on the build agent.

TLAUTORUN “Techlog Autorun” option in the Visual
Studio menu.
Default value: “True”
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TLVERSION “Techlog Version” option in the Visual
Studio menu.

Default value: “Auto”

Remark: If the value is "Auto” or empty,
the Techlog version is resolved from a
.runsettings file.

TLPROJECTPATH Absolute path to a Techlog project to be
used to run tests (only if TLAUTORUN is
set to “"True”).
Default value: empty
Remark: If the value is empty, the
Techlog project path is:

1) resolved from a .runsettings file.

2) not set and tests are run with a temporary

project

TLXMLCOVERAGEFILEPATH | Absolute path to a summary XML file that

contains unit testing code coverage re-
sults.

Default value: empty

Remark: Only available if Visual Studio
Enterprise is installed on the build agent
and TLCODECOVERAGE is set to “True”.

Figure 56 Techlog Test Adapter environment variables

2) Build machine prerequisites

To create and configure build definition on a VSTS build agent to run plug-in tests
through the Techlog Test Adapter follow the steps below.

Note:

It is also possible to run Ocean plug-in tests with the Techlog Test Adapter
on a TeamCity build agent.

Applications listed below need to be installed on the build machine:

Note:

VSTS Build agent
Visual Studio Enterprise 2017 or 2019 (with compiler v141)
Schlumberger licensing tool with a valid Techlog license

Techlog 2016.2, 2017.1, 2017.2, 2018.1, 2018.2, 2019.1, 2019.2 or 2020.1
(depending on which Techlog version you want to run the tests)

Ocean for Techlog 2020.1

It is only described in this document how to setup a build definition with the
Techlog Test Adapter on a VSTS build agent. It is also possible to run
Ocean plug-in tests with the Techlog Test Adapter on a TeamCity build
agent.

3) VSTS build definition setup

Below are detailed steps explaining how to create and configure a build definition on
VSTS that build the plug-in, run the tests in Techlog using Techlog Test Adapter and
compute code coverage results.
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1) Connect to the VSTS page and go to Build and Release menu
2) Select the Definitions tab and click on New definition button

€J Ocean/OceanSDKfor.. '  Dashboards Code  Work  Build and Release st - | @ Search wiki in this project

Builds Releases Library Task Groups Deployment Groups  Packages

Build Definitions Search all definitions O [: @ Help

Mine Definitions Queued XAML Sort Name v Built Anytime ~

Folder / Name Default branch summary Queued Running 7-day pass rate Last built

@15-@18 45% A 2 hours ago

I OceanSDK TestAdapter

Figure 57 Create a new build definition

3) Select the source control where the Ocean plug-in solution is hosted.
VSTS Git source:

a. Select a Team project in the drop down list to access VSTS Git reposi-
tories

b. Select a Repository in the drop down list that that contains the plug-in
solution

c. Select the Default branch

d. Click on the Continue button

Select a source

F
I\!/I
Y w) = a ¥
L —1
VSTS Git TFVC GitHub GitHub Enterprise Subversion Bitbucket® Cloud External Git
Team project
=1 Techlog ~
Repository
4 Foundation-Autotest-Environment ~
Default branch for manual and scheduled builds
¥ dev R

Continue

Figure 58 VSTS Git source

TFVC source:
e. Enter the Server path to the repository that contains the plug-in solution
f. Enter the Local path where this plug-in solution has to be copied on the
build machine
g. Click on the Continue button
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Select a source

]
L —]
VSTS Git TRVC GitHub GitHub Enterprise Subversion Bitbucket® Cloud External Git
Workspace mappings
Type Server path Local path under $(build.sourcesDirectory)
Map - 5/Ocean/2018/DEV/Techlog/Tests/TestAdapter s TestAdapter

Figure 59 TFVC source

4) In the build definition template page select an Empty process

Select a template
Or start with an} & Empty process [

Config as code

ﬁ YAML

Configure your build as code.

Featured

.NET Desktop

Build and run tests for .MET Desktop or Windows Classic Desktop solutions, This template requires that Visual

Studio be installed on the build agent.

ASP.NET

Build ASP.NET web applications

ASP.NET Core

Build ASP.NET Core web applications targeting NET Core

ASP.NET Core (NET Framework)

Build ASP.NET Core web applications targeting the full .NET Framework

Azure Web App

Build, package, test and deploy your Azure Web App.

Universal Windows Platform

Build Universal Windows Platform applications using Visual Studio. This template requires that Visual Studio and

the Universal templates are installed on the build agent

Figure 60 Build definition template page

5) The build definition is now created and you have to provide some settings to the

process that will be run on the build agent:
a. Provide a Name for the build definition
b. Select an Agent queue in the drop down list
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Tasks Variables Triggers Options Retention History = Summary °°- e

Process

Build process ﬁ View YAML
Name *
== Get sources
o Foundation-Autotest-Environment ¥ dev OceanFramework-TestAdapter
Agent queue * @ | Manage =2
Phase 1 I
& Run on agent OceanSDK O

Figure 61 Build definition process settings

6) The build definition is created in VSTS with a default phase named “Phase 1”. This
is under this phase that you will add tasks that which plug-in solution to build in
Visual Studio, the plug-in tests to run with the Techlog Test Adapter for a given
Techlog version / project and compute code coverage results.

7) Add a Visual Studio Build task to the phase that is responsible to build the Ocean
plug-in Visual Studio solution.

Tasks  Variables  Triggers  Options  Retention  History = Summary [> Queue

Process
Build process

Add tasks O Refresh
== Getsources

b Foundation-Autotest.Environment & dex
Ddl Visual Studio Build
Phase 1 D Build with MSBuild and set the Visual Studio version property
S Run onagent E

»q ] Builc solution Test Adspter Plug-in Add a task to the phase f Publish Build Artifacts

sual Studio Build === Publish build artifacts to Visual Studio Team Services/TFS or a file share

Figure 62 Add a Visual Studio Build task

8) Define Visual Studio Build solution parameters as:
a. Display name
Solution: relative path from repository root of the solution
Visual Studio Version
MSBuild Arguments: /p:Platform=x64
Platform: x64
Configuration: release or debug

mooo0oT
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Visual Studio Build @ @ Link settings  [[) View YAML X Remove

Version 1% ~

Display name *

Build solution Test Adapter Plug-in

Solution* @
Ocean-TechlogTestAdapter/TestAdapterPlugin_18_1/TestAdapterPlugin_18_1.sln

Visual Studio Version (@

Visual Studio 2015 4
MSBuild Arguments (D

/p:Platform=x64

Platform (@

x64

Configuration @

release

Clean (@

Figure 63 Visual Studio Build solution parameters

9) An optional step is to add an Extract Files task to the phase that is responsible to
unzip a Techlog project hosted in your Ocean plug-in solution and used to run tests
in Techlog.

Tasks  Variables  Triggers  Options  Retention  History Summary  [> Queue

Process
Build process

Add tasks O Refresh
== Getsources

»q Foundation-Autotest-Environment  § dev
l\ Extract Files
Phase 1 m Exiract a variety of archive and compression files such as .7z, rar, tar.gz, and zip
 Runonagent :
g || Build solution Test Adapter Plug-in Add a task to the phase Marketplace ~

Visual Studio Build

Figure 64 Add an Extract Files task

10) Define Extract Files parameters as:
a. Display name
b. Archive file patterns: relative path to the zip file from the plug-in so-
lution repository
c. Destination folder

Extract Files @ @ Linksettings [ View YAML X Remove

Version 1% '

Display name *

Extract Techlog projects

Archive file patterns * @

TestAdapter\TechlogProjects.zipx

Destination folder * (@
C\TechlogProjects

Clean destination folder before extracting @

Figure 65 Extract Files parameters
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11) Add a Visual Studio Test task to the phase that is responsible to run the Ocean
plug-in tests through the Techlog Test Adapter.

Tasks Variables

Process

z= Getsources

Triggers ~ Options  Retention  History B Save & queue D Discard = Summary

Add tasks U Refresh

»q Foundation-Autotest-Environment

Phase 1
& Runon agent

,,ql Build solution Test Adapter Plug-in Adda task to the phase

A VsTest - testAssemblies

ct Techlog projects

Cl

Figure 66 Add a Visual Studio Test task

12) Define Visual Studio Test parameters as:

a.

b.

C.

-h

Display name

Select tests using: Test assemblies

Test assembies: relative path to test plug-ins output dll that contains
Ocean unit tests. The file paths are relative to “Search folder” parameter
Search folder: folder to search for “Test assemblies” (relative path to the
local build folder)

Test platform version

Settings file: path to .runsettings file to use with the tests that contains
for each test assembly a Techlog version and a Techlog project against
Ocean unit tests have to be run

Path to custom test adapters: directory path to the custom Techlog
Test Adapter (e.g. C:\Program Files (x86)\Microsoft Visual Studio
15.0\Common7\IDE\Extensions\Slb.OceanSdk.Techlog.TestAdapter)
(only if the “Test platform version” is set to “Visual Studio 2017" or “Visual
Studio 2019")

Build platform: set to x64

Code coverage enable: this property is disabled as we don't want to use
VSTS code coverage but the code coverage provided with the Techog Test
Adapter

Other console options: /UseVsixExtensions:true

/2N If the Build platform property isn't set to x64 or the .runsettings
file doesn't contain the tag <TargetPlatform>x64</TargetPlatform>
then it is safer to add the /Platform:x64 to the Other console options

property.
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Visual Studio Test & @ Link settings  [0] View YAML ¥ Remove

Wersion | 2.+ e

Display name *

WsTest - testAssemblies

Test selection A

Select tests using * 3@

Test assemblies B

Test assemblies =

TesthyFirstPluginhxbd\ S BuildConfiguration |\ TestMyFirst®lugin dil
TesthdyFirstPlugininbd \S{Build Configuration)\TesthyFirstPlugin dll

Search folder* @

| ¢{System DefaultWarkingDirectory]\Geean - TechlogTestAdapter, TestAdapterPlugin_18_1 |

Test filter criteria &

D Run only impacted tests &

I:‘ Test mix contains Ul tests &
Execution options

Select test platform using &

(® vemsion () Specific lacatian

Test platfarm version &

Visual Studio 2015 e

Settings file @

Ocean-TechlogTestAdapter/TestAdapterPlegin, 18_1Aechiog. unseitings

Owerride test nun parameters

Path to custom test adapters

I:‘ Run tests in parallel on multi-core machines 5

D Run tests in imolation )
D Code coverage enabled &
COther conscle options &

M sE s

[ rerun tailed tasts @

Advanced execution options
Reporting options «~

Test run fitle &

Build platform &

il |

Buikd configuration @
| $BulldConfiguration) |
. Upload test attachments (&

Figure 67 Visual Studio Test parameters

13) Add a Publish Build Artifacts task to the phase that is responsible to publish in
artifacts of the build agent the results of the plug-in unit tests code coverage.
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Tasks  Variables  Triggers Options  Retention  History = summary D> Queue

Process
Build process R
Add tasks O Refresh
== Get sources
oq Foundation-Autotest.Environment 2 der

4 Copy and Publish Build Artifacts
Phase 1 [I] === [DEPRECATED)] Use the Copy Files task and the Publish Build Artifacts task instead

& Runonagent

5] Build solution Test Adapter Plug-in Add a task to the phase f Publish Build Artifacts

Visual Studio Build Publish build artifacts to Visual Studio Team Services/TFS or a file share

Figure 68 Add a Publish Build Artifacts task

14) Define Publish Build Artifacts parameters as:
a. Display name
b. Path to publish: the folder path to publish the code coverage results on
the build machine or on the repository
c. Artifact name

Publish Build Artifacts ® @ Link settings  [f] View YAML X Remove

Version 1% ~

Display name *
Publish Artifact: Code coverage unit tests
Path to publish* (@D
C:\Temp\CoverageResults
Artifact name * (0

CoverageResults

Artifact publish location* (@)

Visual Studio Team Services/TFS ~

Control Options

Output Variables ~

Figure 69 Publish Build Artifacts parameters

15) Add Techlog Test Adapter environment variables to the build definition (see Error!
Reference source not found.). Build definition environment variables are
available in all build definition tasks created previously.

a. Click on Variables tab of the build definition
b. Add Techlog Test Adapter environment variables to the page that the build
agent needs to use to run Ocean plug-in tests in Techlog

Tasks  Variables  Triggers  Options  Retention  History = Ssummary > Queue

Process variables

Name T Value a Settable at queue time
Variable groups BuildConfiguration release
Predefined variables 12 BuildPlatform x64
system.collectionld a00d461b-cf15-473¢
false
543
TLAUTORUN True
TLCODECOVERAGE True
TLVERBOSEMODE False
TLVERSION Auto
TLXMLCOVERAGEFILEPATH C:\Temp\CoverageResults\CoverageResults.xml
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Figure 70 Build definition environment variables
16) Click on Save & queue button to queue the build definition on the build agent.

4) Unit test results

The build definition runs on the build agent and creates a build result that can be
visualized in the Builds tab of the Build and Release menu. When you click on a
recently built item in the Queued list, it shows you the unit test results as below:

Builds Releases Library TaskGroups Deployment Groups —Packages

QceanFramework-TestAdapter / Build 602977
& Editbuild definition &P Queue new build.. ~ L Download alllogsaszip @ Retainindefinitely 7 Release

Build failed

I "l Build 602977 &
tion Test Adapter Plug-in --malln Ran for 3.2 minutes (OceanSDK), completed 50 seconds ago

+ Extract T

log projects Summary Timeline Code coverage®  Tests

X VsTest -

Completed Runs

© Publ a co Total tests Failed tests Test failures Test duration
+ Post Job Cleanup ’ 5 Passed () 1 B New ()
(-3 ™ Faildq) ) Existing ()
+ Finalize build ? 5 Othersp =0 I
G | I [— .l
+ Report build status
B Column options Groupby Testrun W [1] VSTest Test Run release x64
¥ Filter by test name S| % clear | T -1 Completed 2 minutes ago, Ran for S0 seconds

Showing 5 of 5 test results. Comments

Test T Failingsince  Failingbuild  Duration No comments

« A\ 4/5 Passed - VSTest Test Run release... 0:00:00.000 Error message

© GTestName1.OkTest 0:00:00.000 No error message

© TestMyFirstPlugin2_PluginTest.Faili.. 2 minutes ago Cyrrent build 0:00:00.000
Attachments (1)

@ TestMyfFirstPlugin2_PluginTest.Test... 0:00:00.000

Name T Size
@ MyOceanTechlogTests.NewWellCo... 0:00:00.000

admin_BUILDT1-TMN 2018-04 ... 9K
@ MyOceanTechlogTests.RemoveMis... 0:00:00.000

Figure 71 Build definition unit test results

Note: As you can see in Figure 72 the code coverage summary XML file generated
by the Techlog Test Adapter isn't exploitable directly by VSTS and can't be
displayed in this dashboard.

The code coverage summary XML file is created by the Techlog Test Adapter in the
build artifacts.

¢ Editbuild definition & Queue newbuild.. ~ - Downloadalllogsaszip il %
Build succeeded Artifacts Explorer
I Il“ Build 201804197 A
. Ran for 9.3 minutes (OceanSDK), completed 6.1 hours ago ~ il CoverageResults
Summary  Timeline Code coverage®  Tests esultsTxml
Name [} CoverageResultsd.xml
CoverageResults Download

Figure 72 Coverage result file in build artifacts

Create an installer for your plug-in

The Ocean for Techlog Visual Studio templates deployed by Ocean WIX installer
provide a project template that allows plug-in developers to package their plug-ins
through a WIX installer. You must have WIX 3.8 or a higher version installed to use the
Ocean Plug-in installer template.
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To create a plug-in installer project using Visual Studio:

Add a new plug-in installer project to the solution that contains the Ocean plug-in
project that you want to package by right clicking on the solution in the Solution
Explorer and selecting Add > New Project. In the Project types area, under Visual
C++ project type, select Ocean > Techlog 2020.1. Then select the Ocean Plug-in
Installer template.

Note: An installer project cannot be created in an empty Visual Studio solution.
The installer project wizard uses the main plug-in project in the solution.

Provide the name “MyFirstPluginInstaller” for the project. Click the OK button to start
the Wizard. (See Figure 73.)

Add New Project ? *
P Recent = Sort by: | Default % a5 ar trl+
F stall o = Vi +
i Ocean Plug-in Visual C++  Type: Visual C++
4 Visual C++ . Create Ocean plug-in installer for Techlog
Windows Desktop Ocean Plug-in Installer Visual C++ 20201
B Cross Platform )
Joean Tes i Ca4
MEC/ATL Ocean Test Plug-ir Visual C
CLR
Test A
o Ocean Plug-in Installer template
her
4 Ocean
Techlog 2018.1
Techlog 2018.2
Techlog 2019.1
Techlog 2019.2 Ocean Project type
Techlog 2020.1 /
v
Not finding what you are looking for? Project name

Open Visual Studio Installer /
Name: |

| MyfFirstPJugininstaller

Location: C\Users\lguenoux\source\repos\MyFirstPlugin - Browse...

Figure 73 New project window

The plug-in installer wizard appears (See Figure 74).
Set these inputs:

Title: title of the Ocean plug-in to be installed
Company: company name that owns the Ocean plug-in; displayed during
plug-in installation

e Description: description of the Ocean plug-in; displayed during plug-in in-
stallation

e Projects: select the Ocean plug-ins in the solution to package in the installer

Click Finish in the dialog.

Note: The plug-in dll and its resources built or copied at the post build in the
project output directory are packaged in the plug-in WIX installer by the
Ocean plug-in installer wizard.
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;"!l Mew Ocean for Techleg Plug-in Installer Project Wizard - Step 1 of 2

Ocean for Techlog Plug-in Installer Project Details

Please set the options of your new plug-in installer.
Title: | My first plug-in

Company:  |Schlumberger

Projects: %
[+] MyFirstPlugin

[] TestMyFirstPlugin

Next > Cancel

Figure 74 Plug-in installer wizard

The WIX installer project for “MyFirstPlugin” is added to the Visual Studio solution. Build

the project; a MSI installer is generated in output of the build. Use it to deploy the
plug-in in Techlog to the plug-in users.

Solution Explorer = 0 X
@ o--¢FE|
Search Solution Explorer (Ctri+5) P~

fal Solution 'MyFirstPlugin' (3 projects)
b [%] MyFirstPlugin
[ [<g] References
b [ Dlls
[ Images
[ AdditionaComponents.wis
[ CustomWixULInstallDirwxs
=] LGPL.b¢t
[ Productows
=] README.txt
= SecondLicense.rtf
B [ TestMyFirstPlugin

Figure 75 Plug-in installer project
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Deploy folders and files with the plug-in dll

You may have to deploy additional files with your plug-in dll that follow a particular
folder hierarchy. The WIX installer created through the Ocean plug-in installer template
allows you to add those files by editing the Product.wxs file.

Consider a plug-in activity that creates a Logview from a layout template stored at the
plug-in level.

void SetupLogviewActivity::run()
{
Lock lock = LOCK_CREATE_AND_ACQUIRE_ALL(lock);

Project project = Session::current().mainProject();
Workspace workspace = Session::current().currentWorkspace();

// Apply the template for all the wells in the projects
QList<Well> wells = project.wells().toList();

LogviewTemplate logviewTemplate =
LogviewTemplate::get(StoragelLevelPlugin, "Well9 short");

LogviewTemplateDataBinding logviewTemplateDataBinding =
LogviewTemplateDataBinding(logviewTemplate, wells);

Logview logview =
Logview: :create(workspace, logviewTemplateDataBinding);

lock.release();

stop();
}

The layout template Well9_short.xml must be deployed with the plug-in dll in a
folder named “LayoutTemplates”.

The Ocean plug-in installer wizard dialog allows you to do this.

Browse to a folder on the disk and add it or add a virtual folder that is created at plug-in
installation time.

1. Add “LayoutTemplates” folder to plug-in folder
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Q New Ocean for Techlog Plug-in Installer Project Wizard - Step 2 of 2 *
@ Ocean for Techlog Plug-in Installer Project Details
Please set the options of your new plug-in installer.

L=[E]x

4 [ATechlog User Folder
4 [ Extensions
4 I:IScthrnberge'
4 3 MyfFirstPlugin
4 [@20201
« @10
MyFirstPlugin.dll
& ocean.png

I LayoutTemplates

< Previous Finish Cancel

2. Click on the “Add files” button to browse on the disk and add the
Well9_short.xml file to the new “LayoutTemplates” folder or drag and drop
directly the file from a window explorer to the new “LayoutTemplates” folder.

5_0] Mew Ocean for Techlog Plug-in Installer Project Wizard - Step 2 of 2 X |

Ocean for Techlog Plug-in Installer Project Details

Please set the options of your new plug-in installer.

31 EIEJEY

<[ Techlog User Folder
4 [ Extensions
4 3 schiumberger
4 23 MyFirstPlugin
4 (320201
«@10

MyFirstPlugin.dil
& ocean.png
4 [ LayoutTemplates
B Welld_SHORT xml|

Source: Chwork\OceanForTechlog\Techlog_data\demo-project\Welld_SHORTxml

< Previous Finish Cancel

You can also delete folders and files with the Remove button. When you are
happy with folder structure and files that will be deployed with the plug-in, click Finish

in the dialog. Then the Ocean plug-in installer is added to the Visual Studio solution with
folders and files added to Product.wxs file.

After the fact the plug-in installer content can be modified opening back the plug-in
installer project wizard by right clicking on the plug-in installer project in the Solution
Explorer and selecting Ocean Plug-in Installer Wizard.
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Build
Rebuild

Fe

Clean

Bl Ocean Plug-in Installer Wizard...

Scope to This
B New Solution Explorer View
B, Show on Code Map 1
Build Dependencies k

Add »

Manage NuGet Packages...

+
& Cut Ctrl+X
X
O

Remove Del

Rename
Unload Project
¢* Open Folder in File Explorer

f’ Properties Alt+Enter
-

Figure 76 Update plug-in installer project

Plug-in WIX installer designed with Techlog deployment options

A plug-in end user can deploy a plug-in at the Techlog, Company or user level.

This deployment option is clearly exposed in the destination folder window of the WIX
installer wizard as shown in the screenshot below:
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51 My first plug-in Setup L= [

Destination Folder
Click Mext to install to the default folder or dick Change to choose anather.

Install My first plug-in to:
(@) User folder

(") Company folder

() Techlog folder

(") Other

C:\UsersYguenoux\AppDataRoamingSchlumberger \Techlog',

Change...

Selected plug-n installation directory:
C:\Users\lguenowd\AppData\Roaming\Schlumberger\Techlog

[ Back ][ Mext ] [ Cancel

Figure 77 Techlog deployment options
Change the license agreement text of the plug-in installer

A plug-in installer is created with a default Lorem ipsum text that shows up as the
plug-in license agreement text during the plug-in installation.

5 My first plug-in Setup L= (eS|

End-User License Agreement

Please read the following license agreement carefully

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod
tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim
veniam, quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea
commodo consequat. Duis aute irure dolor in reprehenderit in voluptate
velit esse cillum dolore eu fugiat nulla pariatur. Excepteur sint occaecat
cupidatat non proident, sunt in culpa qui officia deserunt mollit anim id est
laborum.

[¥]1 accept the terms in the License Agreement

Print ] [ Back ][ Mext ] [ Cancel

Getting Started 71
Schlumberger Private - Customer Use

Schlumberger-Private



Figure 78 Default "Lorem ipsum” license agreement text

In order to replace the default Lorem ipsum text by your plug-in license agreement
text, you have to:

1) add a License.rtf file that contains you license agreement text at the root folder of
the WIX project

2) add the License.rtf file to the WIX project in the Visual Studio solution

3) build your solution
User folder versus company folder deployment

A plug-in is uniquely identified in the module manager by its key
VendorName/PluginName/TechlogVersion/PluginVersion.

This information is set in the code of the plug-in (plug-in information of the main plug-in
class) and the plug-in information has to match the plug-in folder structure:
Extensions/VendorName/PluginName/TechlogVersion/PluginVersion.

See “Writing the plug-in” section on page 21 for details on how to declare plug-in
information.

If two plug-ins with the same key are deployed in user and company folders, they show
up both in the Techlog module manager.

You can see in the information pane of the Techlog module manager at which level the

plug-in is deployed.
@ MyFirstPlugin

Version 1.0

DLL name: MyFirstPluging4 D.dll
Ocean version: 20181

evel: Company

Released on: 2/ 20,2018
Created by: Schlumberger
Vendor: Schlumberger
Supported by: jsrith@slb.com

Description:
This is my first plug-in

Figure 79 Level where the plug-in is deployed
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Upgrade an existing Ocean plug-in to the current Ocean release

It isn't a prerequisite to uninstall previous Ocean framework versions before installing
the 2020.1 release. You may have several Ocean framework versions installed on your
machine.

If you open an Ocean plug-in project created with a previous Ocean template and
wizard version, you can upgrade this project to the current Ocean framework version
by right clicking on the project in the Visual Studio Solution Explorer. Then right
click Upgrade Ocean for Techlog Project in the context menu.

Solution Explorer

o o~ g @,

&l

Solution "GettingStarted’ (2 projects)
F e

£y Build

Rebuild nal Dependencies

Clean der Files

View p lurce Files
Ice Files

Analyze | .
irstPlugin

Project Only b

Retarget Projects

IH Upgrade Ocean for Techlog Project

Scope to This

New Solution Exp|0r@r View

3% @)

Show on Code Map
Figure 80 Upgrade Ocean for Techlog project

The upgrade window opens, asking you to confirm the project upgrade.
Do you want to upgrade selected projects to Ocean for Techlog 2020.1 Alpha 2?

[v] GettingStarted 2018.1

* Only project(s) configurations will be updated. No source code will be modified (deprecated APIs should
be handled by a user).

* The associated *.vcxproj files will be modified.

* Your project(s) will be saved and automatically unloaded and reloaded after the upgrade.

Yes No, thanks

Figure 81 Upgrade window

Getting Started 73
Schlumberger Private - Customer Use

Schlumberger-Private



Then an information message warns you about changes that have been applied to the
Ocean for Techlog plug-in project.

Upgrade Ocean for Techlog Project - O X

Do you want to upgrade selected projects to Ocean for Techlog 2020.1 Alpha 27

v GettingStarted 20181 Success | Show logs

* Only project(s) configurations will be updated. No source code will be modified (deprecated APIs should
be handled by a user).

* The associated *,vcxproj files will be modified.

* Your project(s) will be saved and automatically unloaded and reloaded after the upgrade.

All projects were upgraded successfully,

Close

Figure 82 Upgrade information message

The Ocean for Techlog properties are automatically upgraded to the new release during
the upgrade process. Those properties are displayed in the Ocean plug-in
properties dialog window opened from the Visual Studio project contextual menu.

Ocean Plug-in Pmperti{; - O >
Configuration: | All configurations N

Plug-in settings

Plug-in name MyFirstPlugin o
Plug-in version 1.0 O
Vendor name Schlumberger o
Deploy to Techlog

TLUSERDIR CAUsers\lguenoux\AppData\Roaming\Schlumberger\Techlog O
Test settings

Techlog project [.]C
Version

TechlogSDKHome $(TechlogSDKHome2020_1) v O
Techlog versien 1

Qt version

GTests version v14

Qt directory LTechlogSDKHome\3rdparty\Qt §(QtVersion) O
GTests directory ~ $(TechlogSDKHome\3rdparty\Google.Test $(GTestsVersion) [ O

ok || Cancel

Figure 83 Ocean for Techlog project properties

In this dialog window you have access to four groups of properties:

1) Plug-in settings: allow you to give mandatory plug-in information values like
plug-in name, version and vendor name. Changing those values will deploy the
plug-in output dil with the corresponding plug-in structure folder at post-build time.
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2)

3)

4)

Deploy to Techlog: allow you to change the path to the Techlog user folder
where the plug-in is deployed at the post build time

Test settings: allow you to specify the path to a Techlog project that will be used
to run Ocean unit tests in Techlog through the Techlog test adapter.

Version: this group of properties allows you to handle the Ocean for Techlog
binary versions (TechlogSDKHome), Qt binary versions (QtDir) and Google tests
binary versions (GTests) with which you want to build your plug-in. If you create an
Ocean project plug-in from a 2020.1 template or upgrade an Ocean plug-in project
to the 2020.1 release, the default values for those properties are the
TechlogSDKHome2020_1 environment variable value, QTDIR and GTests values
stored in property sheets installed with the Ocean framework 2020.1.

If you change those values through the Ocean plug-in properties dialog, the new
values are only set at the user level and the TechlogSDKHome environment
variable value or other properties defined in property sheets at the project level
remain unchanged.

Techlog version, Qt version and Gtests version are linked respectively to the Ocean
framework version, Qt libraries version and Google tests libraries version both
deployed with the Ocean package. This means that you can’t change manually
those properties through the Ocean plug-in properties window.

See the “Ocean for Techlog property sheets” section on page 16 for more
information on Ocean properties deployed with the Ocean framework package.
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